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This document describes the corporate actions supported by Calypso, how to define
corporate actions, and how to apply corporate actions to trades and positions.
Corporate Actions are defined and applied to trades and positions from Trade Lifecycle >
Corporate Action > Corporate Action. They can also be applied using the scheduled task
CORPORATE_ACTION.
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1. Corporate Actions Overview
See Corporate Action Definition Window for complete details on the Create panel in the Corporate Action Window.

Refer to Calypso Corporate Action Elections for details on the election process.

See CA Apply Trade Simulation Report for information on simulating the application of corporate actions.

For information on applying corporate actions see the following topics:

Corporate Actions for position-based products - Coupons and redemptions on bonds, corporate actions on equity
positions / sec lending trades / repo trades.

Corporate Action for Listed products - Splits, MDEs, and dividends on listed products.

Corporate Actions for OTC products - Splits and dividends on OTC equity derivatives.

Corporate Actions for CFD products

Refer to the Calypso Warrants User Guide for information on creating and applying corporate actions to Warrants.

The following reports allow monitoring corporate actions:

Corporate Actions

Corporate Action Activity

Corporate Action Audit
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2. Corporate Actions Definition
Corporate actions are created from the Create panel of the Corporate Action window.

For bonds, coupons and redemptions can be automatically created in the Generate panel of the Corporate Action
window.

See Corporate Actions for position-based products for details.

CA events can be imported from external sources using the integration and processing of MT564-MT568 Swift CA
events.

For the integration of Swift CA events, see Integrating Swift Corporate Action Events for details.

For the integration of Swift CA events from Indeval, please refer to Calypso CA Indeval Integration for details.

2.1 Supported Corporate Actions
The following corporate actions (CA events) are supported in Calypso. This table also provides the mapping between
the CA Swift Code and the Calypso Model and Subtype to be used.

SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

ACTV

SUSP

Trading Status active

Trading Status suspended

GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

BIDS Repurchase offer/Issuer
bids/Reverse Rights

REOR CASH

SECU

NOAC

Closing position
against security
and/or cash
movements

ACQUISITION

ACQUISITION

REFERENTIAL

CASH_OFFER

SECU_OFFER

REFERENTIAL

BMET Bond holder meeting CONY

PROX

CONN

NOAC

CASH

REFERENTIAL

REFERENTIAL

REFERENTIAL

CAPITALRETURN

REFERENTIAL

REFERENTIAL

REFERENTIAL

BONU Bonus/capitalization issue DISN SECU Additional securities
@ 0 price

ACCRUAL

ACCRUAL

BONUS

STOCK_DIV

BPUT Early redemption CASH

NOAC

REDEMPTION

REFERENTIAL

REDEMPTION

REFERENTIAL

Nasdaq Calypso
Corporate Actions / Version 18



SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

BRUP Bankruptcy REOR CASH

SECU

NOAC

No CA trades
generated

REDEMPTION

REDEMPTION

REFERENTIAL

REDEMPTION

REDEMPTION

REFERENTIAL

CAPD

CAPG

Capital Distribution

Capital Gains distribution

DISN CASH

SECU

Cash movement or
security movement

CASH

ACCRUAL

ADJUSTMENT

REINVEST

CAPI Capitalization GENL NOAC No CA trades gen-
erated

REFERENTIAL REFERENTIAL

CERT Non-US TEFRA D Cer-
tification

GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

CHAN Change - Referential GENL SECU

NOAC

Closing position +
New position @
equivalent price

MERGER

REFERENTIAL

MERGER

REFERENTIAL

CLSA Class action / Proposed
settlement

REOR NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

CMET

MEET

OMET

XMET

Court Meeting

Meetings

Ordinary General
Meetings

Extraordinary / special
meeting

GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

CONV Conversion DISN SECU

NOAC

Change convertible
bonds into
underlying shares
using a pre-stated
conversion
price/ratio

TRANSFORMATION

REFERENTIAL

CONVERTIBLE

REFERENTIAL

CONS Consent GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

COOP Company option REOR SECU

SECU

SECU

CASH

NOAC

Opening Position
against cash
movement and/or
closing position at
price = specified
price

MERGER

MERGER

REDEMPTION

REDEMPTION

REFERENTIAL

RIGHTS_CALL

MERGER

REDEMPTION

REDEMPTION

REFERENTIAL
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SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

CREV Credit event GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

DECR Decrease in value DISN CASH Cash movement CASH ADJUSTMENT

DLST Trading status delisted REOR CASH

SECU

CASH

SECU

NOAC

Closing position
against cash

Closing position
against security
movement and/or
cash movement

No CA trades
generated

ACQUISITION

ACQUISITION

REDEMPTION

REDEMPTION

REFERENTIAL

CASH_OFFER

STOCK_OFFER

REDEMPTION

REDEMPTION

REFERENTIAL

DFLT Bond default GRNL NOAC

CASH

Cash movement with
0 amount

Cash movement

CASH

CASH

DEFAULT

PREMIUM

DRCA Cash Distribution From
Non-Eligible Securities
Sales

DISN SECU

CASH

NOAC

Closing position REDEMPTION

REDEMPTION

REFERENTIAL

REDEMPTION

REDEMPTION

REFERENTIAL

DRIP

DVOP

Dividend Reinvest

Dividend Option

DISN CASH

SECU

NOAC

SECU

SECU

CASH

SECU

CASH

SECU

Cash movement

Additional securities
@ adjusted cash
price

CASH

ACCRUAL

REFERENTIAL

ACCRUAL

MERGER

ACQUISITION

REDEMPTION

REDEMPTION

ACCRUAL

DIVIDEND

REINVEST

REFERENTIAL

STOCK_DIV

RIGHTS_CALL

CASH_OFFER

REDEMPTION

REDEMPTION

EQUITYOFFERING

DSCL Disclosure GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

DTCH Dutch auction REOR CASH

SECU

NOAC

Closing position
against Cash
movement

ACQUISITION

ACQUISITION

REFERENTIAL

CASH_OFFER

STOCK_OFFER

REFERENTIAL
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SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

DVCA

SHPR

Cash Dividend

Share Premium Dividend

DISN CASH Cash movement CASH DIVIDEND

DVSE

DVSC

Stock Dividend

Script Dividend/ Payment

DISN SECU

SECU

Additional securities
@ 0 price

ACCRUAL

ACCRUAL

TAX

STOCK_DIV

EXOF

MRGR

Exchange Offer

Merger

REOR CASH

SECU

CASE

NOAC

Closing position
against cash

Closing position
against security

Closing positions
against cash and
security

No CA trades
generated

For equity swaps,
the original trade is
terminated

ACQUISITION

ACQUISITION

ACQUISITION

REFERENTIAL

CASH_OFFER

STOCK_OFFER

STOCK_OFFER

REFERENTIAL

EXRI Call on intermediate
securities

REOR SECU

SECU

CASH

SECU

NOAC

Closing position +
Reopening new
position at price of
rights

MERGER

REDEMPTION

REDEMPTION

ACCRUAL

REFERENTIAL

RIGHTS_CALL

REDEMPTION

REDEMPTION

OVER

REFERENTIAL

EXTM Maturity extension REOR NOAC

SECU

No CA trades
generated

Closing position +
New position

REFERENTIAL

TRANSFORMATION

REFERENTIAL

ASSIMILATION

EXWA Exercise Warrant GENL SECU

SECU

Closing position ACCRUAL

EXIPRY

EXERCISE

EXPIRY

INCR Increase in Value REOR CASH Cash movement CASH DIVIDEND

INFO Information Only GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL
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SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

INTR Coupon payments on
Bonds

DISN CASH Corporate action
trades for Cash
payments and
realized P&L

CASH INTEREST

INTEREST_
SHORTFALL

INTEREST_
REIMBURSE

PRINCIPAL_
SHORTFALL

PRINCIPAL_
REIMBURSE

LIQU Liquidation
dividend/Payment

REOR CASH

SECU

CASH

SECU

NOAC

Closing position at
price = 0 or at a
specified price

ACQUISITION

ACQUISITION

REDEMPTION

REDEMPTION

REFERENTIAL

CASH_OFFER

STOCK_OFFER

REDEMPTION

REDEMPTION

REFERENTIAL

MCAL Full Call / Early
Redemption

REOR SECU

CASH

Corporate action
trades for cash and
security payments

Corporate action
trades or buy/sell
trades (if
environment
property BOND_
REDEMPTION_
TRADE is set to true)
for closing original
positions

REDEMPTION

REDEMPTION

CALL_
REDEMPTION

CALL_
REDEMPTION

NOOF Non official offer to repur-
chase securities

REOR CASH

SECY

NOAC

Closing position
against security
and/or cash
movements

ACQUISITION

ACQUISITION

REFERENTIAL

CASH_OFFER

STOCK_OFFER

REFERENTIAL

ODLT Odd lot sale / purchase REOR CASH

NOAC

Cash movement

No CA trades
generated

CASH

REFERENTIAL

ODD_LOT

REFERENTIAL

OTHR Other GENL NOAC No CA trades
generated

REFERENTIAL

CASH

REFERENTIAL

DS_FEE
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SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

PARI Pari Passu REOR SECU Closing position +
New position @
equivalent price

TRANSFORMATION ASSIMILATION

PCAL PPRINCIPAL: This is a
partial redemption of an
Amortizing bond

CALL_REDEMPTION:
Redemptions of callable
bonds based on call
schedules provided the
“Exercised?” column is set
to “Yes”

REOR SECU

CASH

SECU

CASH

CASH

Corporate action
trades for cash and
security payments

Corporate action
trades or buy/sell
trades (if
environment
property BOND_
REDEMPTION_
TRADE is set to true)
for closing original
positions

REDEMPTION

REDEMPTION

REDEMPTION

REDEMPTION

AMORTIZATION

CALL_
REDEMPTION

CALL_
REDEMPTION

PRINCIPAL

PRINCIPAL

AMORTIZATION

PINK Pay In Kind

PIK_INTEREST: Used for
Brady bonds to reflect
interest amortization
(Regular Amortization +
PIK Interest)

PINK: Used for Danish
mortgage bonds to allow
redemption of principal
without a cash payment to
offset the value of
negative coupon
payments

DISN CASH Corporate action
trades for Cash
payments

Corporate action
trades security
movement with no
Cash payment

AMORTIZATION

REDEMPTION

PIK_INTEREST

PINK

PLAC Place of Incorporation GENL N/A No CA trades
generated

REFERENTIAL REFERENTIAL

PPMT Installment Call DISN CASH

SECU

CASH

Closing position +
reopening existing
position reflective of
increased avg cost

REDEMPTION

REDEMPTION

CASH

REDEMPTION

REDEMPTION

INSTALLMENT_
CALL
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SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

PRED AMORTIZATION: Used for
sinking bonds to reflect
notional amortization

PAYDOWN: Used for
Asset Backed bonds to
reflect pool factor
changes

REOR CASH

CASH

Corporate action
trades for Cash
payments

Corporate action
trades for Cash
payments and
realized P&L

AMORTIZATION

PAYDOWN

AMORTIZATION

PAYDOWN

PRIO Priority issue REOR SECU

SECU

SECU

CASH

NOAC

Opening Position
against cash
movement and/or
closing position at
price = specified
price

MERGER

MERGER

REDEMPTION

REDEMPTION

REFERENTIAL

ACCRUAL

CASH

RIGHTS_CALL

MERGER

REDEMPTION

REDEMPTION

REFERENTIAL

EXERCISE

RIGHT_ISSUE

REDM Final Maturity REOR SECU

CASH

Corporate action
trades for cash and
security payments

Corporate action
trades or buy/sell
trades (if
environment
property BOND_
REDEMPTION_
TRADE is set to true)
for closing original
positions

REDEMPTION

REDEMPTION

REDEMPTION

REDEMPTION

REDO Redenomination REOR NOAC

SECU

No CA trades
generated

Closing position +
New position

REFERENTIAL

TRANSFORMATION

REFERENTIAL

ASSIMILATION

REMK Remarking Agreement DISN NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

RHDI Intermediate securities
distribution

DISN SECU Additional securities
@ 0 price

ACCRUAL RIGHTS_CPN

Nasdaq Calypso
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SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

RHTS Rights Issue / Subscription
Rights / Rights Offer (as
one event)

REOR SECU

SECU

CASH

NOAC

SECU

SECU

SECU

CASH

SECU

Opening Position
against cash
movement and/or
closing position at
price = specified
price

ACCRUAL

ACCRUAL

CASH

REFERENTIAL

ACCRUAL

MERGER

REDEMPTION

REDEMPTION

ACCRUAL

EXERCISE

OVER

RIGHT_ISSUE

REFERENTIAL

RIGHTS_CPN

RIGHTS_CALL

REDEMPTION

REDEMPTION

EQUITYOFFERING

SMAL Smallest Negotiable Unit GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

SOFF Spin Off DISN CASH

SECU

Cash movement

New security
position @ price 0, or
using adjustment
factor and cash
movement

CASH

SPINOFF

ADJUSTMENT

SPINOFF

SPLF

SPLR

Stock Split

Reverse Stock Split

DISN

REOR

SECU Closing position +
New position @
equivalent price

TRANSFORMATION SPLIT

TEND Tender acquisition,
Takeover, Purchase offer,
Buyback

REOR CASH

SECU

NOAC

Closing position
against security
and/or cash
movements

ACQUISITION

ACQUISITION

REFERENTIAL

CASH_OFFER

STOCK_OFFER

REFERENTIAL

TREC Tax Reclaim DISN NOAC

CASH

No CA trades
generated

Cash movement

REFERENTIAL

REFERENTIAL

REFERENTIAL

CASH

WRTH Worthless REOR CASH

SECU

Closing position at
price = 0 or at a
specified price

REDEMPTION

REDEMPTION

REDEMPTION

REDEMPTION

WTRC Withholding Tax Relief Cer-
tification

GENL NOAC No CA trades
generated

REFERENTIAL REFERENTIAL

N/A Market disruption events N/A N/A Closing position +
New position @
equivalent price

EXPIRY MDE
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SWIFT
Code

CA Event Name SWIFT
Proc

Options Outcome MODEL SUBTYPE

N/A Used for the amortization
of Danish Mortgage Bond

N/A N/A Corporate action
trades for cash and
security payments

Corporate action
trades or buy/sell
trades (if
environment
property BOND_
REDEMPTION_
TRADE is set to true)
for closing original
positions

For Sec Lending
trades, the original
Sec Lending trades
are reduced with
drawing amount
(partial return) and
cash claims are
generated by the
CA.

REDEMPTION DRAWING

N/A Asset impairment in the
context of JGAAP and
USGAAP accounting
requirements

N/A N/A Buy / Sell trades for
closing original
positions

TRANSFORMATION IMPAIRMENT

2.1 .1 Def in ing Corporate Act ions
From the Calypso Navigator, navigate to Trade Lifecycle > Corporate Action > Corporate Action, and select the
Create panel.

The definition of corporate actions (CA events) depends on the corporate action model and subtype. Combinations of
supported models and subtypes are specified in the domain "corporateActionType" as "MODEL.SUBTYPE".

Nasdaq Calypso
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» You can click Load to load an existing corporate action, or click New to clear the screen to create a new corporate
action.

Then fill in the fields described below, and click Save to save your changes. You can now apply the corporate
action to trades and positions.

You can click Apply to bring up the Apply panel with pre-defined selections.

» You can click Deactivate to deactivate a corporate action.

The Deactivated checkbox will appear checked and the CA will not be processed.

Important Note: Deactivating a CA does not cancel existing trades on the CA. To cancel existing trades, you need
to cancel the CA trades using Deactivate > Revert.
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NOTE: To deactivate a CA adjustment created by the Transformation report, you need to delete it instead of
deactivate it.

» You can choose Deactivate > Reactivate to reactivate a deactivated corporate action.

» You can choose Deactivate > Revert to cancel existing trades for a corporate action, and restore the original
state before the corporate action was applied. This should be performed once you deactivate a corporate action.

» Following fields have been added to the Corporate Action Window:

New Face Value

Preview Face Value

CA Trade Attributes:

Notional New Face Value

Notional Previous Face Value

These criteria have been added to the CAMatchingConfig for MT564 and MT566 integrations.

These fields only apply to PCAL Corporate Actions.

 Ⓘ [NOTE: All functions are also available fAcom the Action menu]

 Ⓘ [NOTE: When you select the CA Swift Code, it populates the model and subtype with default values, and
drives the selection of the other fields- Some fields only appear for certain types of corporate actions]

Fields Details - Event Definition
The Event Definition is set by the system upon saving.

Fields Details - Deactivated

Fields Description
Deactivated The Deactivated checkbox appears checked when the corporate action has been

deactivated using the Deactivate button.

The scheduled task CORPORATE_ACTION ignores deactivated corporate actions.

CA Status Only appears if the CA Swift Code is not set.

Select the CA status as needed - The following status codes are defined out-of-the-box in
domain "CA.Status".

• APPLICABLE - Indicates that the CA can be applied - The list of applicable status codes
is defined in domain "CA.ApplicableStatus". CAs with applicable status codes will be
applied by the CA process.

• NOT_APPLICABLE - Indicates that the CA cannot be applied by the CA process.

• CANCELED / REMOVED - The CA is canceled / removed - The list of canceled status

Nasdaq Calypso
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Fields Description
codes is defined in domain "CA.CanceledStatus". The CA process will cancel any trade
generated on this corporate action.

If not set, it is APPLICABLE by default.

Function of the
Message

Only appears if the CA Swift Code is set.

Displays the function of the SWIFT MT564 message as applicable.

Processing Status Only appears if the CA Swift Code is set.

Displays the status of the SWIFT MT564 message as applicable.

Preparation Date/Time Only appears if the CA Swift Code is set.

Displays the Date/Time at which the last update message was prepared.

Fields Details - Corporate Action

Fields Description
Corporate Action The corporate action name is set by the system upon saving.

You can select an existing corporate action as needed.

CA Id Unique Id given by the system to the corporate action upon saving.

CA Version Version number given by the system upon saving if the corporate action is modified - "0" is
the first version.

Sequence You can enter the priority of generation when multiple CAs have the same date, as needed -
"0" is the highest priority.

Update Related
Issuance

Used for warrants and certificates.

Refer to Calypso Warrants documentation for details.

Liquidation Config This field is currently only enabled for the "TRANSFORMATION.IMPAIRMENT" corporate
action. It allows defining corporate actions based on the liquidation config for asset
impairment in the context of JGAAP and USGAAP accounting requirements.

Refer to the Calypso Weighted Average Cost Setup User Guide - "Asset Impairment" for a
full example.

Static Data Filter You can select a static data filter to restrict the scope of the corporate action.

Product Codes You can enter values for the user-defined product codes as needed.

You can create product codes using Configuration > Product > Code.

Parent Linked CA Certain corporate actions can be linked to a parent corporate action.

Child Linked CA Certain corporate actions can be linked to a child corporate action.

Fields Details - Underlying Product
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Fields Description
Underlying Product Select the product to which the CA applies.

If applicable, it displays additional information on the product:

• Exchange

• Exchange TimeZone

• Underlying currency

• Product codes

You can click to display the product definition window.

Fields Details - CA Swift Code

Fields Description
CA Swift Code Select the CA Swift Code as needed - It populates the model and subtype with default

values, and drives the selection of the other fields.

The mapping between Swift Codes and corporate action types can be defined using Trade
Lifecycle > Corporate Action > CA Swift Event Code.

See Corporate Action Swift Codes for details.

Event Choice Select how the CA event being processed is mandatory, mandatory with options, or
voluntary.

When the event choice of a CA is different from MAND (Mandatory), you can add multiple
outcomes (options) to the CA.

See Defining Multiple Outcomes for details.

Event Process Select if the event is a reorganization event or a distribution event.

Type of Change Select the type of change from the company. Available for CA Swift Code CHAN.

Renounceable Select whether the issued rights can be renounced or not. Available for CA Swift Codes
RHTS, RHDI, EXRI, PRIO, and COOP.

Is Taxable Check to indicate that the event is deemed taxable by Tax authority.

Used to compute the new average price either using the current security average price (not
checked) or the market price at ex date (checked).

Available for CA Swift Codes MRGR and EXOF.

Offeror Enter the name of the company offering stock. Available for CA Swift Codes MRGR, TEND,
and EXOF.

Odd lot quantity Enter the odd lot quantity. Available for CA Swift code ODLT.

Event Condition Stage Select the stage in the CA event lifecycle. Available for CA Swift Code TEND.

Redemption Rate Enter the percentage of the principal that is being redeemed. Available for CA Swift Code

Nasdaq Calypso
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Fields Description
TEND.

Event Restriction Check if any restrictions have been declared at the CA Event level.

Issuer Agent MT564 - TAG95::ISAG

Paying Agent MT564 - TAG95::PAYA

Issuer MT564 - TAG95::ISSU

Transfer Agent MT564 - TAG95::TAGT

Fields Details - Dates

Fields Description
Announcement Date Enter the date the CA event is announced on the market as applicable.

Propagation Date Enter the notification date as applicable.

Ex (Effective) Date Enter the effective date of the corporate action.

Is Ex-Date Inclusive
The eligible position will be the position held at close of business "ex date - 1" if the ex date
is non inclusive. If inclusive, it is the position held at close of business ex date (market
practice is to be non inclusive).

It means that when the system loads the PL position at ex date, it will load any position that
is open at ex date end of day (non inclusive).

By Trade Date
The ex date can be applicable to the trade date position or to the settlement date position
otherwise.

"By Trade Date" should be checked for equities and portfolio swaps.

You also need to add the following values to the domain "generateCA.PortfolioSwap” with
Comment = true to generate the corresponding CAs by trade date:

CASH.DIVIDEND.setIsByTradeDate

TRANSFORMATION.PRICE_CHANGE.setIsByTradeDate

Portfolio Swaps
You can add the following values to the domain “generateCA.PortfolioSwap” with Comment
= true to generate the corresponding CAs with Ex Dividend Date inclusive:

CASH.DIVIDEND.setIsExDateInclusive

TRANSFORMATION.PRICE_CHANGE.setIsExDateInclusive

TRANSFORMATION.SPLIT.setIsExDateInclusive

SPINOFF.SPINOFF.setIsExDateInclusive
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Fields Description
If the trades entered on payment end date are to be considered for reset, then on execution
of Price Change CA - 'Ex-Date' Checkbox should be selected and domain
'exDateTradePreviousCF' should be set as 'True'. The default value of
'exDateTradePreviousCF' is 'False'. If the domain is kept as 'False' (or not Set) then on
execution of Price Change CA - 'Ex-Date' Checkbox should not be selected.

Callable Bonds
The ex date for redemption CA will be set to the notification date if the issuer has the
attribute Bond_Callable and the value is the issuer's name.

On a legal entity whose role is Issuer, you can add the Legal Entity Attribute "Bond_Callable"
with the value as the issuer’s name. Then, on the bond definition, if the issuer is set as the
same issuer, the ex date on the CA will be equal to the notification date. If the attribute is not
set on the legal entity, the ex date will be equal to the redemption date.

CA Holidays
By default, CA holidays are ignored and a CA trade can be booked on a non-business day if
the ex-date falls on a non-business day.

To take CA holidays into account, you need to set environment property IGNORE_CA_
HOLIDAYS to false. In that case, if the ex-date falls on a non business date, the CA trade
date is set to the previous business day.

Record Date Enter the date on which the holder of the security are recognized for entitlement. The record
date is used by the system to determine whether a buyer or a seller is eligible for benefit,
and hence requires a claim to be raised.

See Entitlement Eligibility for details.

Is Record Date Inclusive
Check to make the record date inclusive. It is non inclusive otherwise.

Market Deadline Enter the Date/Time issuer’s deadline to respond, with an election instruction, to a
secondary, to an outstanding offer or privilege.

Election to Coun-
terparty Market Dead-
line

MT564 - TAG98C::ECPD

Election to Coun-
terparty Response
Deadline

MT546 - TAG98A::ECRD

Guaranteed Par-
ticipation Date/Time

MT564 - TAG98C::GUPA

Shareholder Meeting
Date

Enter the date at which the bondholders or shareholders meeting will take place.

Second Meeting MT564 - TAG98C::MET2
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Fields Description
Date/Time

Third Meeting
Date/Time

MT564 - TAG98C::MET3

Period Start Date

Period End Date

Enter the dates on which an order starts and expires, or on which a privilege or offer starts
and terminates.

Election Start Date

Election End Date

Enter the dates during which elections can be processed.

The Election Start Date is set to the Announcement Date by default, and the Election End
Date is set to the Ex Date by default.

Please refer to the Calypso Corporate Action Elections documentation for details on the
election process.

Trading Start Date

Trading End Date

Enter the period during which intermediate or outturn securities are tradable in a secondary
market.

Protect Date Enter the last date a holder can request to defer delivery of securities pursuant to a notice of
guaranteed delivery or other required documentation.

Court Meeting Date Enter the date upon which the Court meeting will take place.

Active From Enter the starting date of validity of the corporate action if applicable.

Active To Enter the end date of validity of the corporate action if applicable.

Fields Details - Corporate Action Type

Fields Description
Is Default Option

Swift Event Option

This applies to multiple outcomes (options) CAs.

See Defining Multiple Outcomes for details.

Model Select the type of corporate action, it defines the processing rules attached to the corporate
action.

All supported models are described above.

Subtype Select the corporate action subtype. It depends on the corporate action model.

All supported combinations of models and subtypes are described above.

Div Reinvest Type Attribute "Div Reinvest Type".

Div Reinvest Price Only applies to DRIP CA events.

Dividend reinvestment price.

You can also specify the following:

• Cash Pay Date

• Payment Gross Rate
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Fields Description
• Div Reinvest Currency

• Div Reinvest FX Rate

Success Percent
(Scale Back Ratio) (%)

Enter the percentage of success.

By Open Trade When checked, the Processing Org's PL position is computed using the FIFO method by
TOQ instead of whole position on the price of open trades only. This does not impact the
Inventory position.

This also applies to Redemption CAs for manually liquidated positions. You can check "By
Open Trade" when domain "bondPartialRedemption" contains Value = true.

Amount Enter the amount applicable for one unit of the corporate action.

Total CA Amount Rounding
You can define the number of decimals for the total CA amount using the domain
“CorporateActionAmount”.

Value = MaxRoundingDecimals

Comment = <number of decimals>

Payment Gross Rate Enter the Gross Dividend Rate Cash dividend amount per equity before deductions or
allowances have been made.

Declared Rate Amount declared by the issuer.

You can also specify the following:

• Declared Currency - Currency declared by the issuer.

• Use Declared Currency - Set to yes to use the declared rate / declared currency, or no to
use the amount /currency.

Tax Free Amount Enter the portion of the gross rate that is tax free.

Payment Net Rate Enter the Net Dividend Rate Cash dividend amount per equity after deductions or
allowances have been made.

Currency Select the currency of the corporate action: by default, it is the currency of the selected
product.

If the corporate action currency is different from the product currency, you can set the FX
rate in the "Other Amount" field.

Rounding Method The rounding method applies when a ratio / scale back ratio is specified.

Select one of the following rounding methods:

• Not Available (FR) - The number of shares/securities is rounded down – Any remaining
share/security is stored in CAAdjustBook.

• Round Up (FR) - The number of shares/securities is rounded up – Any additional
share/security is stored in CAAdjustBook.
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Fields Description
• Round Down (Cash In Lieu) (FR) - The number of shares is rounded down. The number

of securities is rounded down to a multiple of the minimum purchase amount. The
remaining shares/securities are settled in cash.

You need to enter the unit price of the remaining shares/securities in "Cash In Lieu Rate
(FR)". The cash amount is added to the CA trades as a fee. The fee type (for example
CA_ADJ_AMOUNT) is taken from the domain “fractionalShareCashPartFeeType”. The
value must be defined in the form “<product type>.<fee type>”. For example:

– Domain = fractionalShareCashPartFeeType

– Value = Bond.CA_ADJ_AMOUNT

If the domain is not defined, the fee type CA_FEE is used by default.

If the sum of the rounded amounts of the P&L CA trades is different from the rounded
amount of the Agent CA trades, an adjustment P&L CA trade is created.

The adjustment trade is not created if the Agent account has the account attribute
ThirdPartyAccount = True.

• Round Down (No Cash) (FR) - The number of shares/securities is rounded down – Any
remaining share/security is stored in CAAdjustBook.

• Fractional Share - The number of shares/securities is not rounded. Fractional
shares/securities are allowed.

• Natural Rounding (FR) - The number of shares/securities is rounded to the nearest unit –
Any remaining/additional share/security is stored in CAAdjustBook.

• Nearest Half Share (FR) - The number of shares/securities is rounded to the nearest
half-unit – Any remaining/additional share/security is stored in CAAdjustBook.

The other rounding methods are not supported.

Note that for Merger and Transformation, the system creates just one closing trade and a
new trade at the average price of the position.

In the Trade Report, the following columns allow viewing fractions handling: New Quantity,
Old Quantity, and Fractional Shares.

CAAdjustBook
On every book, you can set the attribute "CAAdjustBook" with the name of the book where
the differences will be stored. The book set in "CAAdjustBook" must also have the attribute
"CAAdjustBook" set to itself.

You can auto settle all the Agent CA transfers with a CAAdjustBook using the workflow
transfer rule "UpdateCAAdjustBookLinkedXfer" on the SETTLE and CANCEL actions.

When you apply the SETTLE action on a CA transfer between the Agent and the
CAAdjustBook, all the transfers between the Agent and the same CAAdjustBook will be
settled as well.
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Fields Description

Cash and Redemption CAs
For CA trades with Agent:

When agent attribute CA_Cash_Rounding_Method is set, it is used to determine the rounding
method for the CA events. Otherwise, the currency rounding method is used.

For CA trades with Counterparty:

- When PO is paying and PO agent attribute CA_Cash_Rounding_Method is set, it is used to
determine the rounding method for PO transfers on the CA events.

- When Counterparty is paying and Counterparty agent attribute CA_Cash_Rounding_
Method is set, it is used to determine the rounding method for Counterparty transfers on the
CA events.

- Otherwise, the currency rounding method is used.

To Security Certain types of corporate actions result in the creation of trades on a different product after
the corporate action is applied.

Select the resulting product of the corporate action as applicable.

You can click to display the product definition window.

Payment Date Enter the payment date of the corporate action.

Response Deadline
Date/Time

MT564 - TAG98A::RDDT

End of Securities Block-
ing Period

MT564 - TAG98B:BLOK.

The available codes are defined in domain “CAAttribute.blockingPeriod”.

Market Deadline
Date/Time

MT564 - TAG98C::MKDT

Cover Expiration Dead-
line Date/Time

MT564 - TAG98C::CVPR

EARD: Early Response
Deadline Date/Time

MT564 – TAG98C::EARD

Available Date/Time
For Trading

Only available for equity related corporate actions.

Enter the available date for trading.

The trade keyword CASecurityAvailableDate is populated with that date on the equity CA
trades.

The Available Date is populated with that date as well, when set, for the agent CA transfers.

The UPDATE action should be available in the transfer workflow to allow updating the
Available Date as needed, without any other changes to the transfers, using the transition
SETTLED – UPDATE – SETTLED.

From Ratio Enter the ratio of the corporate action if applicable.
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Fields Description
To Ratio For example From Ratio = 1 / To Ratio = 2 means that 1 unit of "Underlying Product" becomes

2 after the corporate action process (in case of SPLIT for example).

If the "To Security" is set (in case of MERGER for example), 1 unit of "Underlying Product"
becomes 2 units of "To Security".

Cash In Lieu Rate (FR)

Cash In Lieu Currency

Cash In Lieu Pay Date

Used with rounding method "Round Down (Cash In Lieu) (FR)".

• Cash In Lieu Rate (FR) = Cash rate to apply to the remaining shares/securities to
calculate the cash amount.

• Cash In Lieu Currency = Currency to settle the cash amount.

• Cash In Lieu Pay Date = Settle date of the cash amount.

Other Amount Enter a fee amount as needed.

Payment Currency Enter the fee payment currency.

Other Amount Pay Date Enter the fee payment date.

Tax Rate Enter the Withholding Tax Rate Percentage of a cash distribution that will be withheld by a
tax authority (for SWIFT CA codes DVCA, SHPR) or tax Related Rate Percentage of the gross
dividend rate on which tax must be paid (for SWIFT CA code DVOP and DRIP).

ADR Fee Enter an ADR fee amount as needed (for SWIFT CA codes DVCA, SHPR). It can be populated
fromMT564 field :92F::CHAR.

This fee is deducted from the net entitlement calculation:

Net dividend amount = ((Gross Cash Rate * ((1-WHT)- ADR Fee)) when there is no tax free
rate or

Net dividend amount = (Taxable Amount) x ((1-WHT%)-ADR fee) + (Entitled Position x Tax
Free Amount) when there is a tax free rate

ADR Currency Enter the ADR fee currency.

Fields Details - Additional Information

Fields Description
Comment Enter a free form comment.

Adjustment Factor Enter the "manual" adjustment factor used by CA rules to adjust the products (strike,
contract size, etc.).

See Corporate Actions for Listed Products for examples.

Theoretical Dilution
Factor

Enter the theoretical dilution factor used by CA rules to adjust the products (strike, contract
size, etc.).

See Corporate Actions for Listed Products for examples.

Special Dividend Check for special cash dividend to indicate that the dividend is re-invested.
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Fields Description
This is currently for information purposes only.

Dividend Type Select the conditions in which a dividend is paid:

• SPEC: Special Dividend (default choice when "Special Dividend" is checked)

• REGU: Regular Dividend

• INTE: Interim Dividend

• FINL: Final Offer or Payment

Fully Franked Rate Enter the percentage of dividend that can be reclaimed. Only applicable on Australian
equities.

Arbitrage Book Select the book when arbitrage trades are generated.

Please refer to Calypso Corporate Action Elections documentation for details on the
arbitrage process.

Meeting Place MT564 - TAG94E::MEET

Meeting Place 2 MT564 - TAG94E::MET2

Meeting Place 3 MT564 - TAG94E::MET3

New Place of Incor-
poration

MT564 - TAG94E::NPLI

Audit
Click Audit, to view audit information for the CA event - It shows details about all the changes on the CA event.

» You can right-click and choose various functions from the popup menu to configure the display, and save the
display as a template.

Incoming Messages
Click Incoming Message to view incoming messages information if any.
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» You can right-click and choose various functions from the popup menu to configure the display, and save the
display as a template.

Generic Comments
Click Generic Comment to associate / display generic comments for this corporate action.

» You can double-click in the table to bring up the Add Generic Comment window to add generic comments.

» You can right-click and choose various functions from the popup menu to configure the display, and save the
display as a template.

Agent Details
Click Agent Details to add / display agent information related to the CA event - This information is populated when the
CA event is imported fromMT56X messages.
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» You can click Add to add an agent, and click Details to set information for that agent - The fields are described
below.

» You can right-click and choose various functions from the popup menu to configure the display, and save the
display as a template.

See Integrating Swift Corporate Action Events for details.

Fields Description
Agent Agent, SENDER of the message.

CA Reference Swift MT564 field CORP – Corporate Action reference; Reference assigned by the account
servicer to unambiguously identify a corporate action event.

Message Reference Swift MT564 field SEME – Sender’s message reference; Reference assigned by the Sender
to unambiguously identify the message.

Safekeeping Account Swift Safekeeping account (97A::SAFE).

Custodian Swift MT564 Custodian (94F::SAFE//CUST-optional).

Cash Account Swift MT564 Cash account (97A::CASH in the sub-sequence E2 CASHMOVE-optional).

Deadline Displays the Agent's deadline date time.

Time zone Displays the timezone related to the Agent's deadline.

Option 1 Displays the option number in the Swift MT564. If the CA event has multiple options, the
Option field is repeated for each option.

2.1 .2 Def in ing CA for Opt ions
Applies to corporate actions on warrants.

Choose Action > CA Option to define more information related to the delivery of the underlying or the cash following
the expiry/exercise of a Warrant.

Refer to Calypso Warrants Documentation for complete details.

2.1 .3 Def in ing CA Defau l ts
You can create corporate action (CA) defaults for stock splits. The CA defaults store default attributes for rounding:
rounding conventions and decimal precision. The other fields are not used.

Choose Action > CA Defaults for defining CA defaults - They are only used when applying corporate actions to equity
structured options.
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2.1 .4 Def in ing Mult ip le Outcomes
When the event choice of a CA is different from MAND (Mandatory), you can add multiple outcomes (options) to the
CA.

Choose Action > Multiple Outcome > Add Cash Outcome to add a cash outcome, or Action Multiple Outcome > Add
Stock Outcome to add a stock outcome.

It adds a new set of Corporate Action Type attributes to the CA event.

Only the reference CA will be processed but upon processing, all outcomes will be applied.

» Define the corporate action type of the additional outcome as needed.

» Identify the default outcome using the "Is Default Option" parameters - They are described below.

Fields Details - Is Default Option
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This applies to multiple outcomes (options) CAs.

Fields Description
Is Default Option This is checked for the corporate action type of the reference CA by default to identify the

default outcome.

This is not checked for the other outcomes.

Check as needed to identify the default outcome.

CA Option Id Displays the CA ID of the reference CA.

CA Option Version Displays the version number of the reference CA.

Option Status Displays the status of the outcome:

• APPLICABLE for the default outcome.

• NOT_APPLICABLE for the other outcomes.

When a default outcome is changed to non default, the status becomes CANCELED in order
to let the system cancel any existing CA trades.

Option Reference Enter a user-defined reference as needed.

Swift Event Option Select the SWIFT code for the outcome:

• CASE: Cash & Securities – CA option includes a distribution of both cash (based on Cash
Rate) and securities (based on To Security).

• CASH: Cash – Distribution of cash to holders.

• SECU: Securities Option – Distribution of securities to holders

• CONN: Consent Denied – Vote not to approve the event or proposal.

• CONY: Consent Granted – Vote to approve the event or proposal.

• NOAC: No Action – option for the account owner not to take part in the event. This would
include opt-out for class actions and lodging of dissenters’ rights.

• OTHR: Other – Generic CA option to be used in case that no other specific code is
appropriate.

Multiple Products
You can also add products to a given outcome. Choose Action > Add To Product.

It adds a set of "To Security Product" parameters to the CA event.

Upon processing, CA trades will be created for all "to products".
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2.1 .5 Adding Custom Fie lds
The fields that appear for swift codes are defined as CA Attributes in the XML file "CAAttributeDefinition.xml" located
under resources/com/calypso/tk/product/corporateaction.

You can add more CA Attributes to this file as needed, or add a new file directly under resources, and set the name
of the file in the environment property CA_ATTRIBUTE_DEFINITION.

 Ⓘ [NOTE: Changes to resources have to be re-deployed to your application servers. Please refer to the
Calypso Installation Guide for details]

For each attribute, you need to specify the following information:

• Name

• Type

• Domain name (optional) - Domain name that contains the list of possible values for this attribute

• Sequence number (optional) - Order of display on the screen

• Parent property name - Parent attribute under which you want to display the new attribute

• Display name

• Description (optional)

• CA swift events - Swift code for which this attribute should be displayed

Example:
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<attribute name="PaymentGrossRateType" type="String" domainName="CAAttribute.rateType"
sequenceNumber="15" parentPropertyName="Amount">
   <displayName>Rate Type</displayName>
   <swiftEvent>DVCA</swiftEvent>
   <swiftEvent>DVOP</swiftEvent>
</attribute>

2.1 .6 Ent i t lement E l ig ib i l i ty
When stock / bond units are obtained through a corporate action and do not settle prior to the record date of a
subsequent corporate action, those units will not be eligible to participate in the second corporate action.

The same rule applies if there are any long-dated settlement trades that are booked before ex date but do not settle
until after record date The holdings resulting from these long-dated trades are not included in the ex date balance.

Example 1
A position holder exercises a rights issue. A cash dividend event quickly follows and the dividend's record date falls
before the allotment date for the rights.

This means that the new units from the rights issue will not be settled by the dividend's record date and as a result,
those units are not eligible to receive the cash dividend.

Example 2
Similar to Example 1, except the dividend's record date falls after the allotment date for the rights.

This means that the new units from the rights issue will be settled by the dividend's record date and are eligible to
receive the cash dividend.
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Ex/Cum Processing
The Ex/Cum basis of quotation is the basis upon which a security is traded. Ex-dividend securities generally trade on a
"cum" basis, indicating that the securities are entitled to upcoming CA events.

Generally on the ex date of a corporate action, the basis of quotation on the market is "ex" the particular corporate
action event. However, in special circumstances, some markets allow shareholders the right to trade the security
"cum-entitlement" between the ex date and the record date (inclusive). Trades can be executed with a "cum" basis of
quotation after the ex date and are required to be captured in the corporate action entitlement process, as the
entitlement has been transferred as part of the trade.

This entitlement eligibility period is also called the CA event active period between the "ex date - 1 EOD" and the
"record date EOD".

You can override the default entitlement eligibility using the trade keyword CATradeBasis on the trades.

The available values for CATradeBasis are defined in domain "keyword.CATradeBasis". It contains the Swift ex/cum
codes.

The domain name "XferAttributesforMatching" is used to propagate the trade keyword CATradeBasis as a transfer
attribute. The transfer attribute CATradeBasis is used in the CA process to adjust the P&L and Agent position in order
to include transactions that are traded "cum".
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2.1 .7 Withhold ing Tax on ACQUISIT ION/CASH_OFFER
A withholding tax fee of type CA_WHT_PNL can be computed for the CA types EXOF/ACQUISITION/CASH_OFFER,
EXOF/ACQUISITION/CASH_OFFER, and SOFF/CASH/ADJUSTMENT, provided a withholding tax configuration exists.

Fee definition

The withholding tax configuration can be defined using Configuration > Fees, Haircuts, & Margin Calls >
WithHoldingTax Config.

The system will generate the CA P&L trade with settlement amount = net amount and fee CA_WHT_PNL.

There is no fee generated on the Agent trade.

2.2 Viewing Corporate Action Definit ions
You can display the corporate actions defined in the system using Reports > Securities Reports > Corporate Action
Report.

See Corporate Action Report for details.

2.3 XML Import Export
Choose XML > XML Export to export the CA event to an XML file.

You can then choose XML > XML Import to import the XML file you have created into another environment, or use the
format to import other CA events.
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3. Corporate Action Report
The Corporate Action Report allows displaying the corporate actions defined in the system.

For reference, Corporate Actions are defined using Trade Lifecycle > Corporate Action > Corporate Action.

From the Calypso Navigator, navigate to Reports > Securities Reports > Corporate Action Report (menu action
reporting.ReportWindow$CA) to bring up the report.

 Ⓘ [NOTE: You can configure the columns. Sort columns, subheadings and subtotals have to be explicitly
specified. Choose Help > Menu Items for details]

» You can change the pricing details at the bottom of the window - By default, the pricing environment comes from
the User Defaults, and the valuation date is the current date and time.

» You can check / uncheck View > Show Frame > Criteria to display / hide the search criteria.

» Specify search criteria as applicable and click to load the corresponding corporate actions.

» You can select a template, and click to display the number of objects that will be loaded from the database,
before loading the report.

» You can click to print the report results.

Note that for the Pivot view and the Aggregation view, the print icon is disabled.

You can use [Ctrl+P] or [Ctrl+L] to print the report, or you can export the report to Excel and print it from there.
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4. Corporate Action Apply Trade Sim-
ulation Report
The CA Apply Trade Simulation report allows simulating the application of corporate actions.

It allows loading a set of corporate actions and the corresponding positions / trades, and it simulates the application of
the corporate actions in the exact same way as the Apply panel of the Corporate Action window. The only difference
is that it does not allow saving the trades.

For information on how the simulated trades and positions are generated, refer to the following topics:

Corporate Actions for position-based products - Coupons and redemptions on bonds, corporate actions on equity
positions / sec lending trades / repo trades.

Corporate Action for Listed products - Splits, MDEs, and dividends on listed products.

Corporate Actions for OTC products - Splits and dividends on OTC equity derivatives.

From the Calypso Navigator, navigate to Reports > Cross-Asset Reports > CA Apply Trade Simulation (menu action
reporting.ReportWindow$CAApplyTradeSimulation).
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 Ⓘ [NOTE: You can configure the columns. Sort columns, subheadings and subtotals have to be explicitly
specified. Choose Help > Menu Items for details]

» You can change the pricing details at the bottom of the window - By default, the pricing environment comes from
the User Defaults, and the valuation date is the current date and time.

» You can check / uncheck View > Show Frame > Criteria to display / hide the search criteria.

» Specify search criteria to select corporate actions.

Specify search criteria to select trades and positions, they are described below.

Then click to load the corresponding corporate actions, trades and positions.

» You can select a template, and click to display the number of objects that will be loaded from the database,
before loading the report.

» You can click to print the report results.

Note that for the Pivot view and the Aggregation view, the print icon is disabled.
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You can use [Ctrl+P] or [Ctrl+L] to print the report, or you can export the report to Excel and print it from there.

Search Criteria to Select Trades and Positions
• Apply to Position - Check to apply the corporate action to positions. Then select the position criteria.

– BO Position Type - Select the position type: ACTUAL (at record date) or THEORETICAL (at ex-dividend
date).

– BO Position Date Type - Select the position date: TRADE or SETTLE.

– BO Position Aggregation - Select the position aggregation if any.

– BO Position Balance Type - Select the position balance type.

– PL Position Repoed - Check to trigger the dividend pass-through functionality.

• Processing Org - Select a processing organization as needed.

• Product Type - Select a list of product types as needed.

• Position Filter - Select a trade filter as needed (note that SQL generated Trade Filters are not supported).

• Apply to OTC - Check to apply the corporate action to OTC trades (repo trades, sec lending trades, equity
derivatives trades). In that case, the corresponding product types must be selected in the trade filter.

The "Process Baskets" checkbox is only used in the context of corporate actions on Equity Derivatives with
baskets.

• Filter Display - Check to filter on CA position type and agent aggregation.

– CA Position Type - Each CA trade is classified in a position type, agent, claim with counterparty, etc… Select
as needed.

– Agent Aggregation Only - To display only the CA agent trades against the CA Adjustment book

– Show Log Progress - To show the log progress

• Generate Ca First - Check to simulate the CA products when they do not exist. In that case the simulated CA
products have a negative Id and the CA trades have no Trade Ids.

You need to select underlying bond products in order for the CA products to be simulated.
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5. Position-Based Corporate Actions
This document describes how to apply corporate actions to position-based products.

Quick Reference
• Select the Generate panel to generate automatic corporate actions (bond coupons and

redemptions), or select the Create panel to define other types of corporate actions.

See Corporate Actions for the various types of corporate actions that can be defined,
and details on the Create panel.

• Select the Apply panel to apply the corporate actions to the positions.

You can also use the CORPORATE_ACTION scheduled task.

5.1 Generat ing Automatic Corporate Actions
Select the Generate panel to generate corporate actions: this applies to coupons and redemptions, based on bond
product definitions.

Corporate Action window (Generate panel)

Step 1 - Click Add to select the product(s) for which you want to generate corporate actions.

Step 2 - Select the range of dates for which you want to generate the corporate actions.

You can check “Use Ex Date” to select bond cashflows based on the ex date rather than the payment date.

Click Generate CA. The corporate actions related to the selected products and the range of dates is displayed.

You can define the number of decimals of the generated amount in the pricing parameter CA_BOND_ROUNDING.
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When creating a CA for which the floating rate is unknown, the system creates a CA with NOT_APPLICABLE status.
This applies to the CORPORATE_ACTION scheduled task as well.

If the domain “CAForMatching” contains Value = true, the CA Ex (Effective) date is set based on the Bond Ex-Dividend
days.

The status must be defined in the domain “CA.Status” with a comment that starts with “Default”.

For example:

• Value = NOT_APPLICABLE

• Comments = Default not applicable status

Step 3 - Click Save to save the corporate actions. You can now apply the corporate actions to the positions.

5.2 Applying Corporate Actions
Each outcome of a corporate action (CA) is applied to the following types of positions:

• The position computed by the Liquidation engine to update the book’s P&L - A CA trade between the book and
the processing org to update the P&L.

Note that for redemptions, you can elect to generate buy/sell trades rather than corporate action trades. To
enable this feature, set the environment property BOND_REDEMPTION_TRADE to true. The system will create
Buy/Sell trades with the Processing Org for closing out the original positions. The CA that has created the
Buy/Sell trade is kept as a reference in the trade keyword CA_REFERENCE.

For a coupon on an ex-dividend Bond, the "PO" CA INTEREST trade represents the real cash coupon amount
receivable on Ex-Dividend Date (matching the Agent Trade). A second "PO" CA INTEREST trade is generated with
keyword "CAExDivAdjustedDate" and liquidation type "Realized Ex-Div Adjustment", representing a P&L
adjustment trade for the coupon amount receivable as of Coupon End Date (equivalent non-ex-dividend Bond).
This second trade does not have any withholding tax adjustment.

• The inventory position computed by the Inventory engine to represent the actual cashflows - A CA trade between
the book and the agent (nostro/custodian) for payment purposes.

You can configure the system so that Agent trades are aggregated into a specific book. To do so, configure the
specific book in the book attribute "CAAdjustBook" of the initial book.

For example, all Agent trades of book "Global" can be stored in book "CABook". Book "Global" should be
configured so that book attribute "CAAdjustBook = CABook". "CABook" should also have the book attribute
"CAAdjustBook = CABook".

Note that if the trades are not settled, or the settlement has failed, the CA trade is generated between the book
and the counterparty, instead of the agent.

You can settle CA claims in a currency different from the bond / equity currency.

– For dividends, you need to set the settlement currency in the counterparty attribute
CADefaultCurrencyDividend.
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– For coupons, you need to set the settlement currency in the counterparty attribute
CADefaultCurrencyInterest.

The system requires the FX rate between the settlement currency and the default currency on the settlement
date.

• For repos, the actual corporate actions are repaid to the counterparty. So we have a CA trade between the book
and the agent, and a CA trade between the book and the counterparty. You need to check “Load OTC Trades" to
generate corporate actions on repo trades.

Note that the "Repo" product type must be selected in the trade filter.

You can settle the counterparty CA with a currency different from the CA currency. You need to set the
settlement currency in the trade keyword CAClaimCurrency on the source repo trade, or on the repo legal
agreement attribute CAClaimCurrency. The FX rate between the CAClaimCurrency and the CA currency is stored
in the trade keyword CAClaimFXRate and is used to calculate the settlement amount.

• For sec lending trades, the corporate actions are repaid to the counterparty only if the initial trades are settled.
We have a CA trade between the book and the counterparty. You need to check "Load OTC Trades" to see those
trades.

Note that the "SecLending" product type must be selected in the trade filter.

• For security margin calls, the actual corporate actions are repaid to the counterparty as well. So we have a CA
trade between the book and the agent, and a CA trade between the book and the counterparty.

• For client positions, the client CAs are generated, and you can choose to generate the internal CAs (PO view of
the client position) or not, based on the account attribute "CATradeDDAInternal" on the client account. If false
(default), the internal CAs are not generated. If true, the internal CAs are generated.

You can settle the client CAs in a currency different from the bond’s currency.

You need to set the account attribute CADefaultCurrency to the settlement currency, for the Client account
where the bond trades are settled.

The system will set the settlement currency of the CA trade to the currency defined in the CADefaultCurrency
and compute the settlement amount in settlement currency based on the FX rate on the settlement date.

Select the Apply panel.
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Corporate Action Window (Apply panel)

 Ⓘ [NOTE: You can click , and choose Configure Columns to configure the display]

If you add domain value CAApplyPanelDefaults, the pre-existing selection criteria will be cleared.

Step 1 - Enter the Applicable Date - It refers by default to the Ex-Dividend date but you can choose the record date or
the payment date instead.

Enter search criteria to select the corporate action, and click Load (CA). You can also click Add to select individual
corporate actions.

Step 2 - Enter selection criteria to load the positions.

You can save a template from the Apply menu to save the criteria currently selected as a template. You can then load
a template to populate the criteria as needed.

• Apply to Position - Check to apply the corporate action to positions. Then select the position criteria.

– BO Position Type - Select the position type: ACTUAL (at record date) or THEORETICAL (at ex-dividend
date).
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– BO Position Date Type - Select the position date: TRADE or SETTLE.

– BO Position Aggregation - Select the position aggregation if any.

– BO Position Balance Type - Select the position balance type: "Balance" is the full position, "Balance Trading"
is the position without borrowed/lent securities (used in conjunction with "PL Position Repoed").

– PL Position Repoed - Check to split the dividend pass-through between the trading position and the
borrowed/lent position. In this case, you need to select the balance type "Balance Trading".

See Dividend Pass-Through for details.

– BO Aggregation By SubAccount - Check to apply CA on custody position by sub-account.

Please refer to Calypso Security Custody documentation for information on custody positions.

• Processing Org - Select a processing organization as needed.

• Product Type - Select a list of product types as needed.

• Position Filter - Select a trade filter as needed (note that SQL generated Trade Filters are not supported).

• Apply to OTC - Check to apply the corporate action to OTC trades (repo trades, sec lending trades, equity
derivatives trades). In that case, the corresponding product types must be selected in the trade filter.

The "Process Baskets" checkbox is only used in the context of corporate actions on Equity Derivatives with
baskets.

See Corporate Actions for OTC Products for details.

• Apply to Margin Call Position - Check to generate CA claims on margin call positions as needed.

See CA Trades on Margin Call Positions for details.

Then click Generate Trade to load the trades and positions impacted by the selected CA, and apply the corporate
action.

Additional Selection Criteria
You can also choose what types of trades you want to display:

• Internal (CA trades between the book and the processing org to update the P&L).

Note that in this case, you can check “Only Position Aggregation” to only generate internal corporate actions for
positions with aggregation criteria. It is highly recommended however to generate all CA trades.

• Claims (CA trades between the book and the counterparty for margin calls, repos, sec lending trades, and
unsettled / failed transfers).

If you do not want the aggregation ID (if any) to be set on trade keyword InventoryAggId for claim trades, you can
add Value = true to the domain "CAExcludeAggIdTKWCpty".

No aggregation is currently supported on CA Claims generated from repos, sec lending trades and unsettled /
failed transfers.

• Agent (CA trades between the book and the agent for payment purposes).
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Note that in this case, you can check "Agent Aggregation" to only generate corporate actions for the book that
aggregates the Agent trades (book set in book attribute "CAAdjustBook" for the initial book where the trades
were stored).

You can customize the roles to which Corporate Actions can be applied using the domain “CAFilterRoleCheckbox”.

It should contain roles for which you want to generate CA trades. In this case, a corresponding checkbox will be
added to the CA Apply window.

For example, if you add Broker to that domain, a Broker checkbox is added to the CA Apply window. You can then
choose to apply Corporate Actions to brokers.

You can right-click a position and choose the following menu options:

• Show > Underlying Inventory Position to display the corresponding inventory position computed by the
inventory engine.

• Show > Underlying PL Position to display the corresponding position computed by the liquidation engine.

• Show > Diffs with Existing to show any difference in the case the corporate action were already applied.

Step 3 - Click Save All to validate the application of the corporate action and save the CA trades.

Note than even if you do not display all the CA trades, the system will create ALL the necessary CA trades when you
click Save All (except in the case of internal trades if “Only Position Aggregation” is checked, agent trades if "Agent
Aggregation" is checked, and internal trades of client positions if the client account attribute "CATradeDDAInternal" is
false).

From the Apply menu, you can save your preferences for the Apply panel to a template, load a template, and set a
default template.

Note on Applicable Date
The handling of the Applicable Date can be customized as follows.

If the domain “generateCA.Bond” exists with:

• Value = CASH.INTEREST.setIsRecordDateInclusive

• Comment = true

The corporate action CASH.INTEREST is generated with record date inclusive, and CA application will record position
on record date End Of Day.

If the domain “generateCA.Bond” exists with:

• Value = AMORTIZATION.AMORTIZATION.setIsRecordDateInclusive

• Comment = true
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The corporate action AMORTIZATION.AMORTIZATION is generated with record date inclusive.

The domain name can be one of the following:

• generateCA.productType.productSubtype

• generateCA.productType

• generateCA

The more detailed domain name takes precedence. For example, “generateCA.Bond.Generic” takes precedence over
“generateCA.Bond”, which takes precedence over “generateCA”.

If the domain "generateCA.PortfolioSwap" exist with:

• Value = CASH.DIVIDEND.setIsByTradeDate / Comment = true

• Value = TRANSFORMATION.PRICE_CHANGE.setIsByTradeDate / Comment = true

The corresponding CAs are generated by trade date.

Note on Trade Settle Date
If you want to apply the payment lag (as defined in the Bond Product Definition) to compute the Trade Settle Date on
CA Redemption trades, you need to define the following value in domain “CAApply.Bond”.

• Value = REDEMPTION.SettleDateIncludesCouponPayLag

• Comment = true

In this case, Trade Settle Date = Maturity Date + Payment lag (defined in Bond definition). If the comment is “false”, or
the domain value is not set, Trade Settle Date = Maturity Date.

Sample "Internal" Trade for P&L
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Sample "Agent" Trade for Payment
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P&L Adjustments
PL adjustments can be computed for the REDEMPTION, DRAWING and AMORTIZATION models in case of rounding
issues.

The system checks that PO CAs settlement amount = Agent CAs settlement amount + Claim CAs settlement amount.
If there is a difference, it is stored in the CAAdjustment book.

CA Stock Claims
The outcomes of generating CA Stock Claims on security finance positions are the following.

Bond CA Events

The bond CA events affecting the security finance positions are:

• REDEMPTION/PRINCIPAL: A partial return is applied to the underlying security repo trade at payment date.
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• REDEMPTION/CALL_REDEMPTION: A partial or full return is applied to the underlying security repo trade at
payment date.

• TRANSFORMATION/ASSIMILATION: A substitution is applied to the underlying security finance trade at payment
date.

• REDEMPTION/REDEMPTION: The underlying security finance trade is closed.

In all those scenarios, we have both a CA cash claim materialized by a CA trade, and a CA stock claim materialized by
an action on the original security finance trade at CA settlement date.

The CA cash claim represents the cash amount of the amortization, redemption and/or assimilation.

Equity CA Events

For all equity CA events applied to security finance positions, equity synthetic trades are created on the lending
positions to update the P&L once the stocks are returned, and on the borrowing positions, additional transfers are
created (using transfer attributes ClaimId = CA productid and CAFailedXfer=transfer Id of the original Security
borrowing transfer) to update the internal inventory position.

When there are no trading position and the position is only composed of security finance trades, no equity synthetic
trade is created as well as no agent CA trade.

When there are trading positions and security finance positions, equity synthetic trades are created for the lending
position and not for the borrowing position. Additional transfers are created on any additional sec borrowing.

The PNL position check is made at book level. All actions are triggered at payment date.

The Equity CA events affecting the security finance positions are:

• ACCRUAL - When applying the ACCRUAL model, we distribute additional securities. For the part of the position
that is being collateralized, additional CA trades are created as Security Lendings or Repos to create the new loan
exposure brought by the additional securities gained from the CA event.

Example of DVOP where security lending position is on one book and trading position on another book:

Example of a single book for trading and security lending & borrowing position:
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• TRANSFORMATION/SPLIT - An action on the collateralized trade is triggered by the CA process to update the
trade at settlement day, generating transfers to update the inventory.

Example of Reverse Split where security lending position is on one book and trading position on another book:

• SPINOFF/SPINOFF - Additional CA trades are created for the new position introduced by the spinoff.

Example of a spinoff using single book for trading and security lending & borrowing position:

• ACQUISITION/CASH_OFFER and STOCK_OFFER - The underlying security finance trade is closed and additional
CA trades are created for the new position, if any introduced by the CA event.

Example of a multi book tender offer against cash:
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• MERGER/RIGHT_CALLS - The underlying security finance trade on intermediate NIL paid equities is closed and
additional CA trades are created to add securities to the original equity position.

Example of a single book exercising the rights:

5.2 .1 Corporate Act ion Trades Modi f icat ion
When processing the CA, the system loads any existing CA trades in order to see if any amendment or cancellation
need to be applied because the position may have changed or the CA details may have been amended. These trades
are then reversed, and new trades are generated with the proper information.

This is called the CA matching process.

In order to exclude a CA trade from the CA matching process, you can set the trade keyword CAManualAmend to true.

Allowing Generating Corporate Actions by Balance Type
When environment property CA_DIFFERENT_BALANCE_TYPE = true, the CABalanceType is stored on the trades.
When the CA is applied to a different balance type, the existing CA trades are not canceled and new CA trades on the
new balance type are created.
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5.2 .2 Withhold ing Tax on Bond Coupons
When you set the environment property SEC_WITHHOLDINGTAX to True, the withholding tax will be automatically
withdrawn from the coupons, and reclaim fees will be automatically generated for bonds defined with "Apply
Withholding Tax" selected in the Market panel of the Bond Definition window.

Refer to Calypso Fixed Income documentation for details.

5.2 .3 Withhold ing Tax on Bond and Equi ty Cla im CAs
To apply the withholding tax to Bond and Equity Claim CAs, you need to set environment property SECURITY_TAX_
HOLDER_ROLE = true.

The tax rate is selected from the Withholding Tax Configuration, the issuer country is the issuer of securities, but the
holder country can be PO country, counterparty country or default.

You can set the holder using the following domains to determine which Tax Rate to use:

• Domain "Security.WHTPay" for short positions

Value = CounterParty or ProcessingOrg

Default is no Tax Rate applied if not set.

• Domain "Security.WHTReceive" for long positions

Value = CounterParty or ProcessingOrg

Default is ProcessingOrg if not set.

5.2 .4 Withhold ing Tax on Sec Finance Cla im CAs
To apply the withholding tax to Sec Finance Claim CAs, you need to set environment property TAX_HOLDER_ROLE =
true.

The tax rate is selected from the Withholding Tax Configuration, the issuer country is the issuer of securities, but the
holder country can be PO country, counterparty country or default.

You can set the holder using the following domains to determine which Tax Rate to use:

• Domain "SecFinance.WHTPay" for long positions

Value = CounterParty or ProcessingOrg

Default is no Tax Rate applied if not set.

• Domain "SecFinance.WHTReceive" for short positions

Value = CounterParty or ProcessingOrg

Default is ProcessingOrg if not set.
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5.2 .5 Div idend Pass-through
The dividend pass-through is the generation of the withholding tax on cash dividends (DVCA, SHPR, DVSC, DVSE,
DRIP, DVOP).

CA trades on book positions are generated on ex date. When calculating these outcomes, a default pass-through rate
is used as follows:

• Long positions are calculated minus the withholding tax rate that is applicable for the relevant processing org and
country in which the security is listed, since we conservatively assume on ex date that the entire long position will
be in Custody.

– If there is no tax free amount:

Entitled Position x Amount x (1 - WHT %)

– If there is a tax free amount:

Entitled Position x (Amount - Tax Free Amount) x (1-WHT%) + (Entitled Position x Tax Free Amount)

• Short positions are calculated at 100%, since we conservatively assume on ex date that we may be obligated to
pay 100% of the entitlement amount.

Entitlement dividend becomes: gross/net rate * P&L book position

By default, the position direction (long or short) is determined at book level. It is possible however to net a number of
books, and determine the position direction based on the netted position. In this case, the position direction of the
netted position will be applied to each individual book, regardless of their individual position direction.

For example, BOOKA is long and BOOKB is short - The netted position BOOKA + BOOKB is long - Then both BOOKA
and BOOKB are considered long.

The netting is controlled at the Market Place level.

If the underlying equity country is not defined in domain “CANetDividendRule” and if underlying equity MarketPlace
attribute CABookNetting = false (or not configured), and if underlying equity MarketPlace attribute CAApplyNetRate =
true and book attribute CAApplyNetRate = true, then all the books falling under this book attribute will be applied the
WHT Rate regardless of whether the book position is long/short.

If the underlying equity country is not defined in domain “CANetDividendRule” and if underlying equity MarketPlace
attribute CABookNetting = false (or not configured), and if underlying equity MarketPlace attribute CAApplyNetRate =
false (or not configured), then we apply default netting behavior which is:

• If the position is long we apply the WHT rate to the CA event amount to have a net dividend.

• If the position is short, no WHT rate is applied and we calculate a gross dividend.

In order to determine which books you want to net together, set the book attribute CABookNetting to the same value
for the books you want to net together.

For example BOOKA / CABookNetting = NET1 and BOOKB / CABookNetting = NET1 ensures that BOOKA and BOOKB
will be netted together.
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By default, the tax rate is taken from the CA event if set. Otherwise, it is taken from the Withholding Tax Configuration
if any.

You can define withholding tax configurations using Configuration > Fees, Haircuts, & Margin Calls >
WithHoldingTax Config.

» Click New to add a new configuration, and enter the details in the Details area. The fields are described below.

» Then click Save to save your changes. You can specify multiple rates for the same issuing country using static
data filters to determine the context of application of the rates.

Details

Fields Description

Id The ID is unique - It is given by the system upon saving.

Issuer Country Select the country of the bond.

Holder Country Select the country of residence of the processing org that purchased the bond.

WHT Rate Enter the withholding tax rate.

The withholding tax amount will be withdrawn from the coupon amount when the
corporate actions are generated.

FTC Rate Enter the Foreign Tax Credit that exists between the issuer and Holder country if any.

When there is no valid RAS (Relief At Source) document, between the PO and the Tax
Authority, you pay the full WHT rate, and may be eligible to reclaim part of the dividend
amount.
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Fields Description

When there is a valid RAS document between the PO and the Tax Authority, you are
charged the FTC rate instead of the WHT rate, and therefore, there is no need for a
reclaim.

When there is no FTC rate, you are charged the full WHT rate. There is no reclaim.

This is only used to generate accounting entries for the accounting events FTC and
FTC_PROVISION:

• FTC = Entitled Position x (Amount – Tax Free Amount) x (FTC Rate) % x (FTC
Recoverable %)

• FTC_PROVISION = [Entitled Position x (Amount – Tax Free Amount) x (FTC Rate) % x
(FTC Recoverable %)] x -1

The book is CA P&L trade book Attribute FTCP_Book for accounting event FTC_
PROVISION and Attribute FTC_Book for accounting event FTC. If these attributes are not
configured in the book of the CA P&L trade, then the book is the CA P&L trade book.

FTC Recoverable is a percentage set on the PO attribute “FTCRecoverable”.

The Tax Authority is set on the PO attribute “TaxAuthority”.

You can associate RAS (Relief At Source) legal agreements between the PO and the Tax
Authority, and take the RAS legal agreements into account in the withholding tax
configuration through the use of static data filters.

• Valid RAS:

– Legal Agreement of type RAS

– Legal Agreement Status=VALID

• Invalid RAS:

– Legal Agreement of type RAS

– Legal Agreement Status=NOT VALID

Reclaim Rate Enter the reclaim rate if applicable.

The reclaim fee will be generated on the internal coupon CA for P&L impact, and on the
agent coupon CA for payment to the Tax Authority.

The Tax Reclaim Date is set by default to the Ex-Date. It can be configured using the
domain “TaxReclaimDate”. You can set the value to RecordDate instead. The accounting
event RECLAIM_TAX_RD allows recording the tax reclaim on the record date.

You can also generate a Tax Reclaim Provision with the accounting event RECLAIM_
PROVISION.

It is generated when the legal entity attribute PROVISIONABLE is set to Yes on the Tax
Authority.

RECLAIM_PROVISION = [Entitled Position x (Amount – Tax Free Amount) x (Reclaim
Rate) %] x (-1)
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Fields Description

Static Data Filter Select a static data filter if applicable. This is mostly needed if you have multiple rates for
the same issuer country, or in the case of FTC rates.

You can also use the static data filter to restrict the corporate actions to which the
withholding tax is applied.

The static data file must be defined with Groups = CA and must contain CA-related
attributes, or settlement account attributes.

Example:

Effective From

Effective To

Select the start date and the end of the configuration.

This applies if the rates change at a certain date.

Tax Authority Select the legal entity that will receive the reclaim fee if any - This is only used when a
Reclaim Rate is set.

The Tax Authority is a legal entity of role TaxAuthority.

Date Rule Select the date rule that determines the payment frequency of the reclaim fee if any -
This is only used when a Reclaim Rate is set.

You can split the dividend pass-through between the trading position and the borrowed/lent position.

When processing cash CA events such as Cash Dividend or Cash Option of a Merger, and the position has been
financed by a security lending trade, the CA process creates CA cash claim trades for the settlement amount to be
claimed.

When capturing the security finance trade, the "required dividend rate" is populated. This rate is then used to
calculate the dividend claim amount by multiplying the settlement amount by the required dividend rate.

The WHT configuration is used to calculate the net dividend settlement amount using the WHT rate set in the
Withholding Tax Configuration window.

The WHT rate is not used on the security lending claim settlement amounts.

When applying the CA event, check "PL Position Repoed", and select the balance type "Balance Trading" indicating
that CA trades are applied on positions excluding borrowed/lent securities.
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The system creates:

• PL CA trades on trading positions (excluding positions that are borrowed/lent), and applies the WHT rate to
calculate the net dividend amount. Those CA trades are created between the trading books and the PO.

• PL CA trades on borrowed/lent positions, and applies the required dividend rate to calculate the net claim amount.
Those trades are created between the security finance books and the PO.

Splitting the eligible position into what is held and what has been lent and/or borrowed allows to distribute correctly
the PL to the right books.

5.2 .6 Back Off ice Process ing
The CA value should be available in the productType domain.

In order to generate the payment with the Agent (nostro/custodian), you need SDIs (settlement and delivery
instructions) between the processing org and the Agent.

The CA payment trade will generate a posting provided an accounting rule is defined on the CST accounting event
(triggered by any payment event), and the rule is linked to the book for the CA product.

The CA P&L trade does not generate any transfer, so it does not require any SDI. It will generate a posting provided an
accounting rule is defined on the INTEREST accounting event (triggered by LIQUIDATED_POSITION and
UNLIQUIDATED_POSITION events), and the rule is linked to the book for the original product (Equity, Bond, etc.). Note
that the CA P&L trade is liquidated with the original trade, and that the posting will appear on the original trade.

5.2 .7 Coupon Payments on Repo Col latera ls
You can identify a coupon payment made on a repo collateral by using the transfer attribute "UnderlyingSec". The
value is "true" if the transfer belongs to a collateral.

5.2 .8 CA Trades on Margin Cal l Pos i t ions
In the CA Application criteria, you can select “Apply to Margin Call Position” to generate CA claims as needed.

INTEREST CAs, PAYDOWN CAs and REDEMPTION CAs
When "Reinvest Coupon" = true on margin call contract, an additional CA trade with role Counterparty is generated.

This new trade contains trade keyword CATradeMC = “Incoming Coupon” and generates a single cash transfer with
Xfer Attribute MarginCall= MC Contract.

Direction of cash transfer of additional trade depends on the Collateral owner:

• Collateral is Received by CP (CP is collateral owner)

Cash transfer direction = REC

• Collateral is Received by PO (PO is collateral owner)
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Cash transfer direction = PAY

When "Reinvest Coupon" = false, there is no additional CA trade with role Counterparty.

The following domains may provide flexibility to the process in the future.

[NOTE: These domains cannot currently be modified as they do not support other values. They are described for
information purposes only]

- CASubTypeWithoutSecurityFlow: CA subtypes for which no security cashflow is required:

Value = REDEMPTION

Value = DRAWING

- CASubTypeForTransferWithoutMarginCall: CA SubTypes that drive the management of the MarginCall Id transfer
attribute:

Value = INTEREST, Comment = UseInventoryAmountSign

Value = REDEMPTION, Comment = UseSubType

Value = DRAWING, Comment = UseSubType

Value = PAYDOWN, Comment = UseSubType

- CACreateMarginCallAdditionalTrade: Conditions to generate a second counterparty trade. Margin call Reinvest
Coupon, Reinvest Principal and Reinvest Paydown are the main parameters:

Value = Reinvest Paydown, Comment = isCash=PAYDOWN

Value = Reinvest Coupon, Comment = isCash!=PAYDOWN

Value = Reinvest Principal, Comment = isRedemption

Corporate Actions on Segregated Margin Call Accounts
You can transfer corporate actions generated on a segregated margin call account to another account using the
scheduled task CA_TRANSFER_AGENT.

The segregated "from" account needs to have the following account attribute:

XferFromAccount = Yes

The "to" account is configured using the Transfer Agent Config window (menu action
refdata.TransferAgentConfigWindow).
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» Click New to create a new config and enter the fields in the Details panel. Then click Save.

Select a processing org or ALL.

Select an agent or ALL.

Select a currency or ANY.

Enter the "from" account in the GLAccount Name field.

Enter the "to" account in the Account Name field.

Then run the scheduled task CA_TRANSFER_AGENT to generate Transfer Agent trades between the "from" and "to"
accounts.

It only applies to cash corporate actions for which transfer value date = valuation date.
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Attributes:

• CAReference - Enter a CA product ID or all transfers linked to trades with a CAReference are selected.

• CA Type - Select CASH, PAYDOWN or REDEMPTION - Values defined in domain “TransferAgent.CAType”.

• Transfer Status - Select the transfer status as needed.

• Transfer Type - Select the transfer type as needed - Values defined in domain “TransferAgent.TransferType”.

• GL Account - Select the segregated account or all accounts with XferFromAccount = Yes are selected.

The trade keyword CASource and the fields in the "MCC_ADDINFO_CA" domain are propagated to the TransferAgent
trades.

Saving Additional Attributes
The Margin Call Contract attributes defined in the domain “MCC_ADDINFO_CA” are saved as trade keywords “MCC_
<attribute>” on the CA trades on Margin Call positions.

For example, the Margin Call Contract attribute ACADIA_ID is added to the domain “MCC_ADDINFO_CA”. Upon CA
generation, the trade keyword MCC_ACADIA_ID contains the value of MCC attribute ACADIA_ID.

5.3 Sample CASH / ADJUSTMENT
CASH with adjustment cost in the P&L.

Only the following CA events with the CASH option are concerned by the P&L adjustment cost:
l SOFF (Spinoff)
l CAPG (Capital Gain Distribution)
l DECR (Decrease in value)

There is no specific field to create an adjusted cost in the P&L. It is just an update of the P&L with the price of the cash
rate in order to calculate a new average price.

Business Example: Equity.ABC with a position holding = 100,000 shares bought at $2.50 for a settlement cost of
$250,000.00.

The default option to process is a cash receipt using a rate of $1 per share.

At ex-date, the Open position should be updated with the cash rate in order to calculate a new average price of $ 
1.50:

= (original average price [$2.50] - cash rate [$1.00]) = $1.50

At record date, the CA agent trade between the book and the agent is generated and creates the physical
settlement of the cash receipt of $100,000 (no change at this stage).
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Defining CA event CAPG on the underlying equity ACCOR.

Position before applying the CA on equity ACCOR, having a position of 500 shares on book BNP GROUP and 1000
shares on book BNP PARIS.

Applying a CA event CAPG at cash rate = 5 gives us the following CA trades where each original position is sold at the
original average price and bought back at the new average price (original average price - cash rate).

The settlement amount is made by the agent on the total position:
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5.4 Sample ACCRUAL / TAX and STOCK_DIV
ACCRUAL with cash movement to represent the tax amount to be paid on the stock dividend.

This model is used for CA events DVSE and DVSC and calculates the tax amount using a tax rate, taken from the CA
event if set, or from the Withholding Tax Config otherwise.

The tax amount is represented as a CA_WHT_PNL fee in the P&L CA trade and a CA_WHT_AGENT fee in the Agent CA
trade to generate the payment transfer to the Agent.

The tax amount is calculated as follows:

Stock dividend * Par Value * Tax rate (before SR 2024)

Stock dividend * Div Reinvest Price * Tax rate (as of SR 2024)

5.5 Sample SPINOFF / SPINOFF
SPINOFF with cost adjustment to apply to the securities price.

The field "Adjustment Cost" applies to the "To Security Product".

Only the CA event SOFF (Spinoff) with the options SECU and CASE applies to this model.

Spinoff with a SECU option and several "To Products".

Parent security equity.ABC with a position of 100,000 shares at original cost of $2.50 (settlement cost $250,000).

Option: SECU.

Security component 1 details: spinoff to security equity.XYZ from 1 to 1 with an adjustment cost = 5%.

Security component 2 details: spinoff to security equity.DEF from 2 to 1 with an adjustment cost = 15%.

In this case, when the Corporate Action is applied to the position, the following CA trades are generated:

• Sell original holding (100,000 equity.ABC) at the original cost price of $2.50 (settlement amount $250,000.00)

• Buy back original holding at ((cost price) * (1- “ Sum of Adjustment costs defined in the option) or ((100%-5%-
15%) * $2.50) = $2.00, (Settlement amount $200,000.00) updating the new P&L with a cost of $2

• Buy the spinoff security equity.XYZ of 100,000 shares (using the ratio 1 to 1) at an adjusted cost of $0.125 ((=
adjustment cost % - * original cost -)/ ratio) or ($2.50 * 5%) / 1/1, 00 (Settlement amount $12,500.00), updating
the P&L of the new security of $0.125

• Buy the spinoff security equity.DEF of 50,000 shares (using the ratio 1 to 2) at an adjusted cost of $0.75 ((=
adjustment cost % - * original cost -)/2/1 ratio)), or ((15%*2.50) / (1/2), 00 (Settlement amount $37,500.00) 
updating the P&L of the new security of $0.75

P&L effects at ex-date:
l Creation of an additional position of equity.XYZ at average price of $0.125
l Creation of an additional position of equity.DEF at average price of $0.75
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l Update the existing equity.ABC with new average price of $2

Inventory effects at settlement date:
l + 100,000 shares of equity.XYZ
l + 50,000 shares of equity.DEF

Defining the CA event

Applying the CA on a position of 100,000 shares gives us the following CA trades:

5.6 Sample CASH / DIVIDEND on Security Lending Trade
Applying a corporate action event with a Cash outcome against an open Security Lending trade will generate a Cash
claim. The claim is generated as a separate trade under the Counterparty of the Security Lending trade, against the
Corporate Action product, with a transfer attached for the cash settlement.
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By default, the CA process identifies the Security Lending trades based on their Trade open quantity and select all the
Security Lending trades where the settlement date (or trade start date) is on or before record date and where the end
date is after ex-date (in order to exclude all the matured trades).

Then the CA process checks every Security Lending trade transfers to determine the cash claim eligibility based on
the transfer value date and the record date and selects as eligible every transfers settled on or before record date.

5.6.1 Trading Country Setup
On the Equity Definition window, you can set the trading country to indicate where the registry/depository is located.

You can set the following attributes on the Country Definition for the selected trading country to apply different
eligibility rules:

• AutoCompensation = true or false

• ReverseMarketClaim = true or false

• CATradeBasis - true or false

The eligibility rules are described below.

5.6.2 E l ig ib i l i ty Rules
Several rules based on market practices apply for generating a cash claim.

Default Eligibility Rule
By default, any Security Lending contract that is settled or unsettled on or before the Record date of a CA event and
has an open quantity on Record date is eligible for the CA entitlement. This generates a CA cash claim trade in the CA
process.

When the Inventory Position type is ACTUAL, only the SETTLED transfers are eligible to a claim.

When the Inventory Position type is THEORETICAL, all transfers except the CANCELED ones are eligible to a claim.

The counterparty claims are generated from Security Lending trades. The column "Trade_keyword.CAFailedTransfer"
identifies the transfer ID of the Security Lending leg that created the claim.

Ex/Cum Rule
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All Security Lending trades and transfers tagged with the trade keyword CATradeBasis indicate whether the trades
are traded on a Cum/Ex basis - The trade keyword CATradeBasis is set using the SWIFT ex/cum codification
populated into the MT540-MT543 messages, under the Trade Transaction Condition Indicator (field
:22F::TTCO//4!c).

The values for the trade keyword CATradeBasis should be defined in the domain "keyword.CATradeBasis".

• CBNS - Cum Bonus - Trade was executed cum bonus.

• CDIV - Cum Dividend - Trade was executed cum dividend.

• CRTS - Cum Rights - Trade was executed cum rights.

• XBNS - Ex Bonus - Trade was executed ex bonus.

• XDIV - Ex Dividend - Trade was executed ex dividend.

• XRTS - Ex Rights - Trade was executed ex rights.

• SPCU - Special Cum - Trade was executed with a special cum condition.

• SPEX - Special Ex - Trade was executed with a special ex condition.

For trades captured after CA event ex date and settled before record date:

• If trade keyword CATradeBasis = XDIV, the ACTUAL/SETTLE position on record date excludes these trades from
the agent position (calculating a cum position).

• If trade keyword CATradeBasis = <empty>, the ACTUAL/SETTLE position on record date creates claims with
counterparty because the agent includes these trades in its position.

However, if country attribute.CATradeBasis = true, then ACTUAL/SETTLE position on record date should exclude
these trades from the agent position (calculating a cum position), behaving as if trade keyword CATradeBasis =
XDIV.

The country attribute is derived from the equity country of trading.

These trades, when they are flagged as cum or ex need to be either included (cum values) or excluded (ex values) in
the corporate action outcomes as counterparty claims.

The claims are created directly with the counterparty against the adjustment book set for the book used in the
Security Lending trade. If no adjustment book is set, the book used to create the counterparty claims will be the
Security Lending book.

For open Security Lending trades where some partial returns have been made, the system will calculate a claim of the
cumulative remaining amount.

When the Inventory Position type is ACTUAL, only the SETTLED transfers are eligible to a claim.

When the Inventory Position type is THEORETICAL, all transfers except the CANCELED ones are eligible to a claim.

Nasdaq Calypso
Corporate Actions / Version 18

May 2025
Revision 10.0 / Approved

Proprietary and Confidential
Page 66 / 140



May 2025
Revision 10.0 / Approved

Proprietary and Confidential
Page 67 / 140

You can use the transfer workflow action UPDATE_XFER_ATTR to update CATradeBasis information using the
CATradeBasisOverride attribute.

When you apply this action, it brings up the Update Transfer Attributes window, which allows modifying transfer
attributes.

Editable attributes have to be defined in domain "XferAttributes.UPDATE_XFER_ATTR.Editable"
(CATradeBasisOverride). Non Editable attributes that you want to display have to be defined in domain
"XferAttributes.UPDATE_XFER_ATTR.Visible" (CATradeBasis).

Auto-Compensation Rule
This rule applies to certain countries - It is based on country attribute AutoCompensation = true.

The auto compensation process is driven by the fact that the trade was executed prior to the ex-date of the CA event
and that the delayed settlement after record date appears like a "fail". So the market attempts to correct itself.

The sequence of events is as follows for a Security Lending trade:

• Trade executed prior to ex date i.e. 'cum' with a settlement date after record date

• At record date the PO agent position still holds the stock so the Register credits the agent, and the agent credits
the PO account (entitlement part of Agent CA trade)

• At Settlement date, the stock is transferred to the borrower. The Register recognizes that the trade deal was
'cum' so corrects the dividend payments by debiting the PO agent account to pay the counterparty

• CA claim with the PO Agent to PAY the dividend payment to offset the standard Agent trade on record date

• CA claim with the counterparty to RECEIVE the value of the dividend it received by the Register
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Reverse Market Rule
This rule applies to certain countries - It is based on country attribute ReverseMarketClaim = true.

The reverse market process is driven by the fact that the trade was executed after ex-date of the CA event and the
settlement before record date. The market is attempting to 'correct' the dividend flow and in the context of a Security
Lending trade this results in the beneficial owner actually receiving the dividend through the Agent rather than
needing to get it back from the counterparty.

The sequence of events is as follows for a Security Lending trade:

• Trade executed after ex date i.e. 'ex' with a settlement date before record date (trade is SETTLED)

• At record date the counterparty holds the stock so the Register credits their agent (Counterparty claim generated
part of the default claim generation)

• The register recognizes that the trade deal was 'ex' so corrects the dividend payments by debiting the
counterparty account to pay the PO agent - CA Claim with the counterparty to PAY the dividend entitlement in
order to offset the entitlement amount included in the standard claim

• The PO agent credits PO account with the dividend - CA Claim with the Agent to RECEIVE the value of the
dividend

5.7 Sample Cash Claim
From the Calypso Navigator, navigate to Processing > Accounting Operations > Corporate Action Trade to enter
cash claims by linking the trade to an existing CA product.
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Enter the following fields:

• Cpty

• Book

• Trade date

• Settle date

• Direction of the claim (Pay/rec)

• Type - Select the CA product to which you want to attach a claim

• Quantity and CA Unit Amount

Only cash claims can be captured. To capture stock claims, you should enter equity trades.

Saving the trade automatically populates the following trade keywords:

• CAReference = CA product Id

• CAManualAmend = Yes in order to let the CA process know that this is a manual CA trade and that it should not be
amended during the CA Apply process

5.8 Fai led Claims El igibi l i ty Rules

Default Rule
The default rule of claim generation applies to all equity trades whose transfers Trade date < Ex date and transfer
settle date < Record date but are still considered unsettled at Record date (transfer status not SETTLED).
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In that case, a claim is generated with the counterparty.

Example: Equity ULRC.PA (ULRIC DE VARENS) - Country of Trading FRANCE - Auto-Compensation = true

Trade
Id

Transfer
Id

Book Trade
Date

Settle
Date

Quantity Price CA Ex
Date

CA
Record
Date

Transfer
Status

8501 38001 EBU 24/10/201-
2

29/10/201-
2

100 48,00€ 9/11/201-
2

13/11/201-
2

SETTLED

8503 38002 EBU 24/10/201-
2

29/10/201-
2

100 48,70€ 9/11/201-
2

13/11/201-
2

SETTLED

8601 38501 EBU_
LongBoo-
k

5/11/2012 12/11/2012 2,000 44,00€ 9/11/201-
2

13/11/201-
2

VERIFIED

8603 38502 EBU_
LongBoo-
k

2/11/2012 16/11/2012 4,000 39,00€ 9/11/201-
2

13/11/201-
2

VERIFIED

8604 38503 EBU_
LongBoo-
k

5/11/2012 12/11/2012 1,000 47,00€ 9/11/201-
2

13/11/201-
2

SETTLED

8605 38504 EBU_
LongBoo-
k

5/11/2012 16/11/2012 3,000 45,00€ 9/11/201-
2

13/11/201-
2

VERIFIED

When applying a Cash Dividend (3€) on the position, you obtain the following failed claims:
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Auto-Compensation Rule by Country
The Failed Claims generation reflects market practices, applying the Auto-Compensation rule.

Where a market equity trade is traded before Ex Date but is scheduled to settle after Record Date, in an Auto
Compensation market, the corporate action entitlement is automatically paid by the Agent on the date that the market
trade settles.

While these trades are not technically market failed claims, because they are traded 'cum' and have not settled by
Record Date they do need to create CA Claim trades.

This rule applies to certain countries - It is based on country attribute AutoCompensation = true.

This eligibility market rule applies to all equity trades whose transfers Trade date < Ex date and transfer settle date >
Record date. Any CA entitlement is then auto-compensated by the registry/depository once the trade settles.
Settlement date of the Claim is the underlying trade settlement date.

In the above markets, for equity trades where transfer trade date < Ex date, even if the transfer Settlement date >
Record date, a cash claim needs to be generated with the agent only, since the corporate action entitlement is
automatically paid by the Agent on the date that the market trade settles.

Auto-Compensation Rule by Agent and Product Type
This feature can be activated using the environment property AUTO_COMPENSATION_MODEL = CSDBased.

In this case, auto-compensation is defined based on auto-compensation rules defined in the Auto Compensation
Config window (menu item refdata.AutoCompensationConfigWindow).

For each agent and product type, you can select the auto-compensation rule:

• NoAutoCompensation - There is no auto compensation.

• GroupedPositionClaim - All the eligible positions for an account are grouped into a single CAAdjustBook trade if
claim settle date <= CA pay date, or a CAAdjustBook trade per settle date if claim settle date > CA pay date.

• PositionClaimByClaim - The eligible positions for an account are not grouped - Each eligible position generates a
CAAdjust book trade.
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• GroupedAtPrincipalAgent - All the eligible positions are grouped by principal agent. When selected, the principal
agent must be defined in the Principal Agent Config window (menu item refdata.PrincipalAgentConfigWindow).
See below.

GroupedAtPrincipalAgent

When the Sender is a Principal Agent, it is used to index the incoming MT566 messages.

5.9 Sample Bond Assimi lat ion
To transfer the position of a bond to a new bond, you can use the Assimilation corporate action.

Follow the steps below.

Step 1 - In the original bond, select the Special panel and specify the assimilation information: Enter the assimilation
date and select the new bond.

Step 2 - Run the scheduled task CORPORATE_ACTION to create the ASSIMILATION corporate action and apply it to
the original bond.
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Execute the scheduled task on the assimilation date.

A TRANSFORMATION / ASSIMILATION corporate action is created and applied to the original bond.

Two trades are generated: one to close out the position on the original bond, and one to create the position on the
new bond.
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6. Listed Corporate Actions
The process for applying corporate actions to listed products is the following:

• You first create / import the corporate action definition on the underlying equity / equity index.

• Then you adjust the contract using CA rules and the CA Adjustment report - This adjusts the contract, and creates
an adjustment corporate action (ASSIMILATION) to be applied to the listed trades.

• Finally, you apply the ASSIMILATION corporate action to the listed trades.

This process is the same for ETO trades (listed equity options), Future Equity trades, Future / Future Option Equity
Index trades, and Warrants, and applies to the following types of corporate actions:

• DIVIDEND

• MDE (Market Disruption Events)

• SPLIT

• MERGER

• SPINOFF

By default, the new contract is created with Contract Name = "#<source contract name>".

There is also the option of renaming the old contract instead of the new contract using the domain
“ETDClearing.RenameOldETONonSVNContract”.

If “ETDClearing.RenameOldETONonSVNContract” contains Value = true:

• Add a prefix '#' on the Contract Name of Source Contract.

• Add CAClearingExchangeTicker attribute on Source Contract.

• Remove ClearingExchangeTicker, GMIProduct attributes from Source Contract.

• Set Source Contract Name attribute on New Contract.

If “ETDClearing.RenameOldETONonSVNContract” contains Value = false:

• Add a prefix '#' on the Contract Name of New Contract.

Average price is used by default. You can use the domain CAByOpenTrade to use the original price instead of the
average price:

Value = <CA model.CA subtype.product type>

Comment = true

Example:

Value = TRANSFORMATION.ASSIMILATION.ETOEquity

Comment = true
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For these CAs, the price of the new trade is the original price, not the average price.

6.1 Listed Equity Options (ETOs) - SPLIT Example
In the case of ETOs, the SPLIT corporate action is applied to the ETO contract through a contract adjustment. The
contract adjustment creates an ASSIMILATION corporate action that is then applied to the actual ETO trades.

6.1 .1 Creat ing the SPLIT Corporate Act ion
Create the corporate action in the Create panel.

» Select the underlying equity to which the split applies.

» Select the swift code SPLF or SPLR - The corporate action type is set as follows:

Model = TRANSFORMATION and Subtype = SPLIT.

» Enter the split ratio using From Ratio (old shares) / To Ratio (new shares).

» Enter the “Unadjusted Close Price From Quote” to set the underlying equity price on EX Date, when EX Date
quotes are not available. This is only used when the FROM QUOTE operator is selected in Corporate Action Rules
window.

» Enter the adjustment factor (manual factor) / theoretical dilution factor as needed.
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6.1 .2 Adjust ing the ETO Contract
You need to create an adjustment rule for the corporate action using Trade Lifecycle > Corporate Action > CA Rules
(menu action reporting.CARulesWindow).

Set the following details for the target adjustments.

• Action to be applied.

• Factor: NONE, MANUAL (takes the adjustment factor set in the CA), or THEORETICAL (takes the theoretical
dilution factor set in the CA).

• Check "Default Rule".

• Adjustment type - Select one of the following:

– CONTRACTSIZE - To adjust the contract size.

– QUANTITY - To adjust the quantity (position).

– RATIO - In an even split ratio (for example, 1:2, 1:4), the quantity is adjusted. In an odd split ratio (for
example, 2:3), the contract size is adjusted.

– STRIKE - To adjust the strike.

– PRICE - To adjust the price.

– BARRIER - To adjust the barrier.

• Operator - Select whether to MULTIPLY, DIVIDE, ADD, FROM QUOTE or SUBTRACT the adjustment factor. When
FROM QUOTE is selected, the price is calculated using the Korean Exchange formula which adjusts the contract
size with the adjustment factor and requires the underlying equity quote on “EX Date -1” and “EX Date”. If the
quote is not available on EX Date, it is taken from “Unadjusted Close Price From Quote”.

• Rounding - Select the rounding method (NEAREST, UP, DOWN) that will be used for the new contract size or
quantity.

Rounding method NEAR8TH is used in US markets and only applies to strike adjustment. It rounds the strike to
the nearest 1/8.
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• Decimals - Set the number of decimal places to use on the new contract size or quantity.

Then you run the CA Adjustment report to adjust the ETO contracts using Trade Lifecycle > Corporate Action > CA
Adjustment Report (menu action reporting.CATransformationReportFrame).

» Enter the CA date and select the underlying.

» Click Load (CA) to load the applicable corporate actions.

» Select the corporate action you want to apply, and click Generate Adjustments to generate the adjustments.

» Set / adjust the strike / contract size / To Exch clrg ticker / etc. as needed and click Validate All to validate the
adjustments.

You can also select a few rows and choose Validate selected CA Adjustment to validate only the selected
adjustments. If "Adjustment By Contract" is checked (default value), you will be prompted to validate all
adjustments. Otherwise, only the selected adjustments are validated.

» Finally, click Save All to save the adjustments.

New adjusted contracts and options are created, and the corporate actions to be applied to the actual ETO
trades are created.

New option on new contract, with adjusted strike:
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Assimilation corporate action:
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If you check "By Open Trade", the close out trade uses the original trade price to close the position.

6.1 .3 Apply ing the ASSIMILATION Corporate Act ion
Select the Apply panel of the Corporate Action window to apply the corporate action to the ETO trades.

» Enter search criteria to select the corporate action, and click Load (CA).
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You can save a template from the Apply menu to save the criteria currently selected as a template. You can then
load a template to populate the criteria as needed.

» Click Load (Position) to load the trades / positions impacted by the selected CA and apply the corporate action.

The system creates a trade that will close out the original trade, and a new trade with the new contract.

It also creates a CA trade for the agent position.

» Click Apply All to validate the application of the corporate action and save the trades.

Close out trade:

New trade:

The original trade date is saved in trade keyword CAOriginalTradeDate.

6.2 Future Option Equity Index - MDE Example
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6.2 .1 Creat ing the MDE Corporate Act ion

MODEL = EXPIRY

Subtype = MDE

6.2 .2 Adjust ing the Future Opt ion
CA Rule
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CA Adjustment

» Load the CA you want to apply.

» Click Generate Adjustments.

» Check that the information is correct, and click Validate All.

It creates the ASSIMILATION corporate action.
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6.2 .3 Apply ing the ASSIMILATION Corporate Act ion

6.3 Modif icat ion and Cancel lat ion Process
If you modify / cancel a "parent" corporate action (DIVIDEND, MDE, SPLIT), it does not automatically modify / cancel
the adjustment corporate actions. You need to run the scheduled task PROCESS_ADJUSTMENTS to modify / cancel
the adjustment corporate actions.

The steps are the following:

• Modify or cancel a "parent" corporate action as applicable, by changing its status.

• Run the scheduled task PROCESS_ADJUSTMENTS to cancel / modify the related adjustment corporate actions.

• Apply the cancellation / modification to the actual CA trades using the Apply panel of the Corporate Action
window.
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6.3.1 Modi fy / Cancel a "Parent" Corporate Act ion

» Modify the corporate action, and change its status as needed - For example:

– Status = CANCELED - To cancel the corporate action.

– Status = VALIDATED - To reflect the modification of the corporate action.

» Save your changes.

6.3.2 Run the Scheduled Task PROCESS_ADJUSTMENTS
The corporate action's ex-date must be within the range of the "valuation date - from days", and "valuation date + to
days".

The scheduled task loads modified / canceled "parent" corporate actions, and modifies / cancels related adjustment
corporate actions. It only modifies / cancels the corporate action definitions, not the actual corporate action trades.
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» Select the CA type, and select the status codes as follows:

– VALIDATED_STATUS - Status of "parent" modified CAs to be selected - The selected CAs will trigger the
modification of the adjustment CAs.

– CANCELLED_STATUS - Status of "parent" canceled CAs to be selected - The selected CAs will trigger the
cancellation of the adjustment CAs.

– CANCEL_TO_VALIDATE_STATUS - Resulting status of "canceled" adjustment CA.

– PROCESSED_STATUS - Resulting status of "modified" adjustment CA.

6.3.3 Apply the Modi f ied / Canceled Adjustment Corporate Act ions
Depending on the resulting status that you have selected on the adjustment CAs, you may have to confirm the
cancellation / modification.

» In this example, change the status to CANCELED to confirm the cancellation.
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Select the Apply panel, and apply the cancellation to the actual corporate actions trades.
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7. OTC Corporate Actions
This document shows examples of corporate actions applied to OTC Equity Derivatives trades.

 Ⓘ [NOTE: Only splits and dividends are supported for OTC Equity Derivatives trades. In addition, accruals and
mergers are supported for equity swaps]

7.1 Equity Structured Options - SPLIT Examples
The guiding principle of adjustment performed on product and trades due to corporate action is that trades are
adjusted so that the holder is not affected financially by the corporate action: the market value of the trade or position
will not change.

Depending on whether the trade is on a single underlying or a basket, and whether it is defined in quantity or in
notional (performance based), different methodologies are used to modify equity derivatives trades after a corporate
action is applied.

7.1 .1 Methodology Overv iew

Single Underlying - Trade Characteristics Adjustment
For single asset options defined in terms of quantity, the number of shares in the option, as well as trade levels will be
adjusted in order to reflect the new quotation of the stock in the market after the corporate action has occurred.

By trade levels, we mean all trade information that is defined referring to the price of the underlying stock:

• Strike

• Barrier Level

In addition to the quantity itself, the amounts computed using the quantity will need to be adjusted to avoid
unexpected jumps:

• Digital amount

• Barrier rebate

For Corporate Actions inducing a change in the list of the underlying (spin-off, mergers, name change) manual
adjustment are performed for single underlying options on the relevant stock through the cancellation and recapture
of the trades.

Basket Underlying - Basket Modification
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For basket options, the payoff is defined using the basket level when the basket is defined in quantity, in which case
the option trade is also defined in quantity.

In this case, a corporate action will result in a modification of the definition of the underlying basket : quantity
associated with each component may be modified so that the basket level can be properly calculated by taking the
corporate action into account.

Payout Depending on Historical Quotes - Quotes Adjustment
For all types of options where the final payout is defined based on historical quotes, the historical quotes are adjusted
so that the payout can be computed appropriately. The rationale behind the adjustment is to correctly revert the drop
of the stock price observed on the market when the corporate action becomes effective, in order to calculate the
performance of the stock.

This methodology is used in particular for:

• Asian and Lookback options.

• Performance based trades, such as Cliquets, Rainbows and generally speaking structures defined using eXSP.

7.1 .2 Stock Spl i t Def in i t ion
The corporate action is defined in the Create panel.
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» Select the underlying equity to which the split applies.

» Select the swift code SPLF or SPLR - The corporate action type is set as follows:

Model = TRANSFORMATION and Subtype = SPLIT.

» Enter the split ratio using From Ratio (old shares) / To Ratio (new shares).

The corporate action can be applied from the Apply panel, or using the CORPORATE_ACTION scheduled task.

7.1 .3 Apply ing to a Vani l la OTC Opt ion - Sing le Under ly ing
Sample vanilla OTC option trade:
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Select the Apply panel to apply the corporate action:
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 Ⓘ [NOTE: For OTC trades, the Position & OTC Filter must contain the product type of the OTC trades]

» Enter search criteria to select the corporate action, and click Load (CA).

You can save a template from the Apply menu to save the criteria currently selected as a template. You can then
load a template to populate the criteria as needed.

» Check "Load OTC Trades" and click Load (Position & OTC) to load the trades impacted by the selected CA and
apply the corporate action.

The original trade is terminated and a new trade is created with adjusted characteristics.

» Click Apply All to validate the application of the corporate action, and save the trades.

New Trade: The quantity, premium / price and strike are adjusted according to the split ratio.
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7.1 .4 Apply ing to a Barr ier Opt ion - Sing le Under ly ing
Sample barrier option trade:

Select the Apply panel to apply the corporate action:
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New Trade: The quantity, premium / price, strike, and barrier characteristics are adjusted according to the split ratio.

7.1 .5 Apply ing to an Asian Opt ion - Sing le Under ly ing
Sample Asian option trade:
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Asian schedule: The quotes and adjusted quotes are the same since no split has been applied yet to the corporate
action:

Select the Apply panel to apply the corporate action:

 Ⓘ [NOTE: For OTC trades, the Position & OTC Filter must contain the product type of the OTC trades]

New Trade: The quantity, premium, and strike are adjusted according to the split ratio.

Nasdaq Calypso
Corporate Actions / Version 18

May 2025
Revision 10.0 / Approved

Proprietary and Confidential
Page 96 / 140



May 2025
Revision 10.0 / Approved

Proprietary and Confidential
Page 97 / 140

The Asian schedule shows the adjusted quotes.

7.1 .6 Apply ing to a Vani l la Opt ion - Quant i ty Basket Under ly ing
When a corporate action is applied to a trade with a "quantity" basket underlying, it is first applied to the basket, then
to the actual trade.

Applying the corporate action to the basket is done using the CA Basket Generation window.

Then the corporate action is applied to the trades using the Corporate Action window, or the scheduled task
CORPORATE_ACTION.

When applying the corporate action to the trades using the scheduled task CORPORATE_ACTION, you must set the
attribute "Apply to basket" to True.

Sample basket:
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Sample vanilla option trade:

From the Calypso Navigator, navigate to Trade Lifecycle > Corporate Action > CA Basket Generation to apply the
corporate action to the basket.
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» Select the corporate action at the top of the window.

» Click Load Baskets to load the baskets on which the corporate action can be applied. Then select a basket and
click Apply Selected to adjust the quantities of the basket.

Now, the corporate action must be applied to the trade itself. Select the Apply panel in the Corporate Action window.

» Check the Process Baskets checkbox.

The new trade is based on the updated basket.
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7.2 Equity Swap - DIVIDEND Example

7.2 .1 Def in ing a Div idend
Define the dividend CA in the Create panel of the Corporate Action window: CASH.DIVIDEND.
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Depending on the Dividend's payment schedule, the newly created dividend corporate action will impact the
cashflows of the equity swap.

7.2 .2 Apply ing to an Equi ty Swap
Sample Equity Swap:
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Select the Apply panel in the Corporate Action window.
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 Ⓘ [NOTE: For OTC trades, the Position & OTC Filter must contain the product type of the OTC trades]

» Enter search criteria to select the corporate action, and click Load (CA). You can also click to load individual
corporate actions.

» Check "Load OTC Trades" and click Load (Position & OTC) to load the trades impacted by the selected CA and
apply the corporate action.

The original trade is modified with the dividend information.

» Click Apply All to validate the application of the corporate action, and save the trades.
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8. CFD Corporate Actions
In case the liquidation method is different from “CFD”, and the CFD contract is defined with “No Perf” (and therefore
follows the margin call process), the corporate actions are generated using the standard Corporate Action process:

• Corporate Action window to define the corporate actions.

• Corporate Action window or CORPORATE_ACTION scheduled task to apply the corporate actions to CFD
positions.

• For corporate actions with cash transfers, you use the scheduled task CFD_RESET to generate the cash transfers
on reset date (payment of execution fees, funding cost, and CA fees).

Otherwise, corporate actions are generated using the CFD Corporate Action process:

• Corporate Action window to define the corporate actions.

• CFD_CA scheduled task to apply the corporate actions to CFD positions.

• For corporate actions with cash transfers, you use the scheduled task CFD_RESET to generate the cash transfers
on reset date (payment of execution fees, funding cost, and CA fees).

The various types of corporate actions that can be defined are described in Corporate Actions.
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9. Corporate Action Activity Report
This document describes how to use the Corporate Action Activity report.

The Corporate Action Activity report allows reconciling CA payments (CA Agent trades, CA Fail trades, Collateral
pass-thru cashflows, etc.) created by the Corporate Action process for open positions and OTC trades.

From the Calypso Navigator, navigate to Reports > Cross-Asset Reports > Corporate Action Activity Report.

 Ⓘ [NOTE: The columns of this picture have been configured. Sort columns, subheadings and subtotals have
to be explicitly specified. See Help > Menu Items for details]

» You can change the pricing details at the bottom of the window - By default, the pricing environment comes from
the User Defaults, and the valuation date is the current date and time.

» You can check / uncheck View > Show Frame > Criteria to display / hide the search criteria.

» Specify search criteria as applicable and click to load the corresponding transfers and positions that are
subject to corporate actions.

» Click to print the report results.

Note that for the Pivot view and the Aggregation view, the print icon is disabled.

You can use [Ctrl+P] or [Ctrl+L] to print the report, or you can export the report to Excel [Ctrl+O] and print it from
there.

You need to sort the report by processing org, effective date, and CUSIP for example, and setup subtotals for “CA
Payment Amount” and “P/S Position Payment Amount” in order to compare those two amounts.
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10. Integrating Swift Corporate Action
Events
This document describes how to integrate MT564-MT568 and seev.031, seev.035, seev.036, seev.039 Swift
corporate action events.

• A MT564 / seev.031 / seev.035 / seev.039 message is sent by an account servicer to the account holder. This
message is used to provide account holder the detail of the corporate action event. It can be several MT564 /
seev.031 / seev.035 / seev.039 notifications. The account holder can receive an incomplete corporate action
notification replaced by another MT564 / seev.031 / seev.035 / seev.039 with complete information.

• A MT566 / seev.036 message is sent by an account servicer to the account holder. This message is used to
confirm the account holder that security or/and cash has been credited/debited to an account as a result of a
corporate action event.

• A MT568 corporate action narrative is a bi-directional swift message between an account servicer and account
holder. This message is used to provide additional information about a corporate action event.

After a Swift format pre-check to integrate the Swift CA events into the system, the integration process generates a
message, the swift message being stored as an advice document in the message.

Depending on the MT564 / seev.031 / seev.035 / seev.039 content and processing status, the integration can either
create a new CA event or update an existing one with additional information.

MT566 / seev.036 and MT568 are integrated as additional information and linked to a corporate action event when
the system is matching them to the existing ones. If they match any corporate action the system just creates a
message.

There are two ways of integrating Swift CA events into the system:

• Using the MESSAGE_MATCHING scheduled task: Swift CA events are saved as "TXT" files in a specific directory
and processed by the scheduled task.

• Using the Import Message engine: Swift CA events are processed in real time when they arrive in MQ series.

This document shows examples using the scheduled task.

10.1 Before you Begin

10.1 .1 Incoming Message Val idat ion Setup
The environment property VALIDATE_SWIFT_FORMAT should be set to true so that the format of the incoming
message can be validated.
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If the incoming message is not SWIFT compliant, the message is saved with the message attribute "Format Issue"
containing the format exception. In this case the incoming message is not processed (no corporate action create /
update).

When processing the incoming message in order to create or update the CA event, an issue can also occur because of
missing reference data. In this case, the message attribute "Process Issue" is set on the message with a description of
the issue.

Add the following values to domain "MsgAttributes" so that you can see those attributes:

• CAReference: ID of the corporate action product

• Process Issue: Attribute used to store the reason why the MT56X processing has failed

• Process_Status: Content of TAG 25D::PROC//

• Format Issue: Attribute used to store the reason why message is not swift compliant

• Message_Function: Content of TAG 23G

• ISIN: Content of TAG 35B

• Swift_Event_Code: Content of TAG 22F::CAEV//

• Payment_Date: Content of TAG 98A::PAYD// (else 98A::EFFD//)

• Ex_Date: Content of TAG 98A::XDTE// (else 98A::MATU//)

• Record_Date: Content of TAG 98A::RDTE//

• AgentRef: Content of TAG 20C::SEME//

• CA_Agent_Ref: Content of TAG 20C::CORP//

• Period_Rate: Content of TAG 92A::INTP//

• Fixed_Rate: Content of TAG 92A::INTR//

• Quantity Type: Used to identify the sub-sequence CASHMOVE/SECMOVE

• Del Type: Used to identify the direction of the movement (DEBIT/CREDIT)

• Nominal Amount: Content of TAG 19B::PSTA//

• Ccy: Settlement currency

• Settle Date: Content of TAG 98A::POST//

• Settle Date Time: Content of TAG 98C::POST//

/Document/CorpActnMvmntConf/CorpActnConfDtls/SctiesMvmntDtls/DtDtls/PstngDt or
/Document/CorpActnMvmntConf/CorpActnConfDtls/CshMvmntDtls/DtDtls/PstngDt or
/Document/CorpActnMvmntRvslAdvc/CorpActnConfDtls/SctiesMvmntDtls/OrgnlPstngDt or
/Document/CorpActnMvmntRvslAdvc/CorpActnConfDtls/CshMvmntDtls/OrgnlPstngD

• Div Reinvest Type: When Tag 22F::OPTF contains RNET, the message attribute 'Div Reinvest Type' is set to NET
and the CA product is created as ACCRUAL/STOCK_DIV. When Tag 22F:OPTF contains RGRS, the message
attribute 'Div Reinvest Type' is set to Gross and the CA product is created as ACCRUAL/TAX with CA_WHT_
AGENT fees
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Same logic applies for seev.31 / seev.36 messages for TAG
/Document/CorpActnNtfctn/CorpActnOptnDtls/OptnFeatrs/Cd

• ALTERNATE_AMOUNT (field Div Reinvest Price): Content of TAG 90B::PRPP//ACTU
(/Document/CorpActnNtfctn/CorpActnOptnDtls/SctiesMvmntDtls/PricDtls/GncCshPricPdPerPdct/AmtPric/AmtPr
icTp or
/Document/CorpActnNtfctn/CorpActnOptnDtls/CshMvmntDtls/PricDtls/GncCshPricPdPerPdct/AmtPric/AmtPricT
p)

• Buy Up Amount: Content of TAG 19B::BUYU//
(/Document/CorpActnMvmntConf/CorpActnConfDtls/CshMvmntDtls/AmtDtls/BuyUpAmt)

• Amort_Rate: Content of TAG 92A:RATE//

• Pool_Factor: Content of TAG 92A:NWFC//

• Redm_Price: Content of TAG 90A:OFFR//

• ReversalReasonCode: Content of tag 24B::REVR for reversal payment messages

• ReversalReasonNarrative: Content of tag 70D::REVR for reversal payment messages

• TAXR: Content of TAG 92::TAXR for cash movement

• TAXRSecurity: Content of TAG 92::TAXR for security movement

• WITL: Content of TAG 92A:WITL for cash movement

• WITLSecurity: Content of TAG 92A::WITL for security movement

• TAXRAmount: Content of TAG 19B::TAXR for cash movement

• TAXRAmountSecurity: Content of TAG 19B::TAXR for security movement

• WITLAmount: Content of TAG 19B::WITL for cash movement

• WITLAmountSecurity: Content of TAG 19B::WITL for security movement

• Resulting Amount – Content of field 19B::RESU

• Capital Gain Amount – Content of field 19B::CAPG

• CINL Amount – Content of field 19B::CINL

• Interest Amount – Content of field 19B::INTR

• Market Claim Amount – Content of field 19B::MKTC

• Net Cash Amount – Content of field 19B::NETT

• Reinvestment Amount – Content of field 19B::REIN

• Stamp Duty Amount – Content of field 19B::STAM

• CashInLieuPercentageType – Content of field 90A::CINL - DISC, PRCT, PREM or YIEL (Allows checking if Cash In
Lieu Payment Rate field is correctly calculated)

• CashInLieuAmountType – Content of field 90B::CINL – ACTU, PRCT, PREM or PLOT (Allows checking if Cash In
Lieu Payment Rate field is correctly calculated)

• CashInLieuPrice: Content of TAG 90A::CINL

Nasdaq Calypso
Corporate Actions / Version 18

May 2025
Revision 10.0 / Approved

Proprietary and Confidential
Page 108 / 140



May 2025
Revision 10.0 / Approved

Proprietary and Confidential
Page 109 / 140

• Fractional Part for Cash: Content of TAG 90B:CINL

• Election Start Date: Content of TAG 69A PWAL

• Election End Date: Content of TAG 69A PWAL

10.1 .2 Ver i f icat ion of Cash In L ieu Payment Rate f ie ld
• For 90A::CINL//DISC, Face Value – [Face Value*(DISC Value/100)]

• For 90A:: CINL//PRCT, Face Value * (PRCT Value/100)

• For 90A:: CINL//PREM, Face Value + [(Face Value*PREM Value/100)]

• For 90A:: CINL//PREM, YIEL Value

• For 90B::CINL//ACTU, ACTU Value

• For 90B::CINL//PRCT, Face Value – DISC Value

• For 90B::CINL//PREM, Face Value + PREM Value

• For 90B::CINL//PLOT, PLOT Value

10.1 .3 Trade Keywords
The following trade keywords must be added in the domain "tradeKeyword":

• CAAgentAccountId: ID of the custodian settle account

• CAAgentCashAccountId: ID of the cash settle account

• CAReference: ID of the CA product

• CAFailedTransfer: ID of the failed transfer for which a CA claim is needed

• CAClaimReason: Reason why a CA claim trade is needed

• CASource

The trade keywords impacted by a Corporate Action event can be copied from initial to new trade after a price
change, by setting a domain value "keywords2CopyUponCA". The trade keywords listed in this domain value are
copied to the new trades generated by the CA process only when the CA is applied by Open Trade.

The Following CA MODEL and SUBTYPES are impacted:

CA MODEL: TRANSFORMATION

SUBTYPES: ASSIMILATION, SPLIT, PRICE_CHANGE

The new trades that are linked to original trade via the trade keywords are:

- Same CAReference
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- CASource

- Or LiquidableWith

This support is only provided to the Portfolio Swap product.

10.1 .4 Domain Values Setup
Add the message type "INC_CA" to the domain "messageType".

Add the following values to the domain "incomingType":

• Value = MT564 - Comment = INC_CA

• Value = seev.031 - Comment = INC_CA

• Value = seev.035 - Comment = INC_CA

• Value = seev.039 - Comment = INC_CA

• Value = MT566 - Comment = INC_CA

• Value = seev.036 - Comment = INC_CA

• Value = MT568 - Comment = INC_CA

You can add the following values to the domain "TradeMessageRef":

• Value = MT566_AMOUNT_CONVERTED

• Value = MT566_RATE

• Value = MT566_AMOUNT

• Value = MT566_CURRENCY

They are set as message attributes and trade keywords by the message workflow rule SetTradeMessageRef.

You can use the following values in domain “CAMatching” to specify the number of decimal places:

• Name = CAMatching

• Value = BondRoundingUnit

• Comment = Number of decimal places after dividing by 100

Example:

If Comment = 4, Bond Rate = 33.45% and Swift Rate= 33.4521%, then after dividing by 100, Bond Rate = Swift Rate =
0.3345.
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10.1 .5 Workf low Setup

Message Workflow
Create the message workflow for the message subtype INC_CA.

Orig Status Action Resulting Status Use
STP

Rules Filter

INVALID AUTHORIZE VERIFIED true CheckIncomingFormat MT566

INVALID CANCEL CANCELED false

INVALID REPROCESS INVALID false ReprocessIncoming

MATCHED UNDO
PEND_SETT_
UPDATE false

NONE NEW INVALID false

PEND_SETT_
UPDATE AUTOINDEX

VER_SETT_
UPDATE true SetXferMessageRef

PEND_SETT_
UPDATE MATCH MATCHED false MatchIncomingSecurity

PEND_SETT_
UPDATE REMOVE REVERSED true ReverseLinkedMessage

REVR
Messages

PEND_SETT_
UPDATE REPROCESS

PEND_SETT_
UPDATE false ReprocessIncoming
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Orig Status Action Resulting Status Use
STP

Rules Filter

PEND_SETT_
UPDATE REVERSE REVERSED false

PEND_SETT_
UPDATE RETRY CANCELED false RegenerateIncoming

VERIFIED AUTHORIZE
PEND_SETT_
UPDATE true CheckIncomingProcess MT566

VERIFIED CANCEL CANCELED false

VERIFIED UPDATE PROCESSED true SetTradeMessageRef MT566

VERIFIED PROCESS PROCESSED true CheckIncomingProcess MT564

VERIFIED RETRY CANCELED false RegenerateIncoming

VER_SETT_
UPDATE AUTOMATCH MATCHED true MatchIncomingSecurity

VER_SETT_
UPDATE

MATCH

Applied from the Security
Matching window MATCHED false MatchIncomingSecurity

VER_SETT_
UPDATE REVERSE REVERSED false

Rules description - They may need to be added to the domain "workflowRuleMessage":

• CheckIncomingFormat - Only applies if environment property VALIDATE_SWIFT_FORMAT is true - During the
MT56x integration process, the attribute "Format Issue" is set on the message with invalid format. This workflow
rule returns true if the attribute "Format Issue" is empty, or false otherwise.

• CheckIncomingProcess - Only applies if environment property VALIDATE_SWIFT_FORMAT is true - During the
integration, the attribute "Process Issue" is set on the message if the incoming message cannot be processed
(cannot generate/update a corporate action). This workflow rule returns true if the attribute "Process Issue" is
empty, or false otherwise.

• ReprocessIncoming - Rule to reprocess a message. Let suppose a reference data is missing in the system. The
MT56x will stay in "INVALID" status. After fixing the missing reference data you can use the REPROCESS action to
execute the ReprocessIncoming rule and reprocess the message.

• ReverseLinkedMessage rule is used to apply the action REVERSE on the linked message in case MT566 REVR is
matched.

• SetXferMessageRef rule is used to store the message id as transfer attribute when incoming MT566 is
successfully indexed. Action UPDATE must be available.

• RegenerateIncoming - Rule to produce an event PSEventReProcessMessage that is consumed by the Import
Message engine to regenerate the incoming message.
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You need to add PSEventReProcessMessage to the domain eventClass. It needs to be consumed by the Import
Message engine. If the Import Message engine is only used to process those types of events, you can run it with
the engine parameter “config = noconfig”.

• SetTradeMessageRef - Sets the message keywords defined in domain "TradeMessageRef" as trade keywords on
CA trades.

Transfer Workflow

Orig
Status

Action Resulting
Status

Use
STP

Rules

NONE NEW PENDING false

PENDING AMEND PENDING false

PENDING AUTHORIZE VERIFIED true CheckNetting

PENDING CANCEL CANCELED false

PENDING EXECUTE VERIFIED false SetKnownFlag

SETTLED REVERSE VERIFIED false UpdateCAAdjustBookLinkedXfer, UpdateCASecurityLinkedXfer

SETTLED UNSPLIT CANCELED false

SETTLED UPDATE SETTLED false

SPLIT REVERSE SPLIT false
UpdateCAAdjustBookLinkedXfer, UpdateCASecurityLinkedXfer,
UnSplitXfer

SPLIT UPDATE SPLIT false

VERIFIED AUTO_ SETTLED true CheckToBeSettled, UpdateCAAdjustBookLinkedXfer,
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Orig
Status

Action Resulting
Status

Use
STP

Rules

SETTLE UpdateCASecurityLinkedXfer

VERIFIED CAMCEL CANCELED false

VERIFIED
PARTIAL_
SETTLE SPLIT false UpdateCAAdjustBookLinkedXfer, UpdateCASecurityLinkedXfer

VERIFIED SETTLE SETTLED false
UpdateCAAdjustBookLinkedXfer, UpdateCASecurityLinkedXfer,
CheckToBeSettled, UpdateINDEVALLinkedXfer

VERIFIED SPLIT SPLIT false

VERIFIED UNSPLIT CANCELED false

VERIFIED UPDATE VERIFIED false

Rules description - They may need to be added to the domain "workflowRuleTransfer":

• UpdateCAAdjustBookLinkedXfer - Used to apply the same action (SETTLE or REVERSE in this transfer workflow)
on transfers attached to the trading books trades.

• UpdateCASecurityLinkedXfer- Used to apply the same action on security transfer of the CAAdjustBook. Thus the
security transfer is automatically SETTLED (or CANCELED in case of REVR) once a MT566 is matched with the
cash CA transfer.

• UnSplitXfer - Used to REVERSE the transfers coming from a PARTIAL_SETTLE in case REVR MT566 is matched.

• UpdateINDEVALLinkedXfer - Used to apply the SETTLE action on transfers coming from CA trades with Agent
INDEVAL.

10.1 .6 Product Code
The MT56x SWIFT documentation advises to use the product code ISIN as security code.

But in certain case you can find MT56x message using different security codes, for example:
:35B:/HK/SR000305
DRAGON HILL WULING
OPEN OFFER

We support ISIN, HK, and US. You can add product codes usingConfiguration > Product > Code, and set its value in
the Equity Definition.

The logic for retrieving the product ID depends on field 94B.

Field 94B is not provided
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1. Get the ISIN (field 35B code Word ISIN).

• If there is only one product id in Calypso for this ISIN return the product id for the matching

• If there is no product id return an error: “No security found for ISIN <ISIN>”

2. If there is more than one product id for this ISIN then get the Place of Safekeeping (field 94a code word SAFE) to
return the country of deposit (to compare to the trading Country).

• If only one record exists return the product id

• Otherwise add the DENO to the matching key list:

– If only one record exists return the product Id

– Otherwise, select the product with product code specified in domain “mt564CustomCode”

Field 94B is provided
1. Get the trading Country (field 94B code word PLIS). This Place of listing is a MIC (standard code of 4 char in
ISO15022 identifying an exchange). From the MIC (stored under the Legal Entity attribute MIC) return the country of
the MarketPlace and compare it to the Trading Exchange of the product Id matching the ISIN.

• If only one record (product Id) remains, use this product id for matching

2. Otherwise, get the denomination currency (field 11A code word DENO) and compare it to the product currency.

• For all product id matched per ISIN + Trading Country, if with the currency only one record remains, return the
product id

• Otherwise, select the product with product code specified in domain “mt564CustomCode”

10.1 .7 Addi t iona l Setup for Bonds

Nostro Accounts
On the Nostro accounts, you need to set the account attribute "XferAgentAccount" to the safekeeping account
number (TAG :97A::SAFE// of the MT56X) so that the proper Nostro account and corresponding SDIs can be retrieved.

If several accounts have the same reference (case of AUTO accounts), we also parse the tag 94F to retrieve the
country of the custodian to be mapped with the account attribute "SubcustodianISO".

The safekeeping account number is stored in the CA Agent Details upon integration, and in the CA trade keyword
"CAAgentAccountId".

Cash Accounts
On the Cash accounts, you need to set the account attribute "XferAgentAccount" to the cash account number
(97A::CASH in the sub-sequence E2 CASHMOVE-optional) so that the proper Cash account and corresponding SDIs
can be retrieved.
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The cash account number is stored in the CA Agent Details upon integration, and in the CA trade keyword
"CAAgentCashAccountId".

CAAdjustBook Definition
MT566 must be matched with a global transfer that represents the amount settled with the agent. To do so, the
system generates an additional CA trade on a CAAdjustBook.

Define the adjustment book, and set the adjustment book in the book attribute "CAAdjustBook" of all trading books.

Legal Entity Tolerance
Tolerance can be defined at sub-custodian, Agent or PO level (to be retrieved in this order). It can be an absolute (ccy
is mandatory in that case) or relative amount. The Legal Entity Tolerance Window can be reached from the Legal
Entity window.

Two types of tolerance are necessary:

• CAAutomatic: case where the amount difference is acceptable and transfer should be matched automatically
when processing the incoming MT566.

• CAManual: case where the amount difference is not acceptable for automatic matching but acceptable for
Manual matching (from the Security Matching window).

In both cases, the system will apply the action PARTIAL_SETTLE on the transfer. The action SETTLE is applied on
transfers attached to all "trading book" CA trades but settle amount is not updated. Settle date should still reflect the
real settle date on these underlying transfers. The action MATCH is applied on the MT566.

Matching Criteria for MT564 and MT566
Matching criteria for those messages are defined in the CA Matcher window (menu action
refdata.CAMatcherConfigWindow).
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It is mandatory to define at least the default date for each Swift Code.

10.2 Integrat ion Process
The scheduled task MESSAGE_MATCHING is used to integrate MT56x messages into the system, process them and
create CA events.

Attributes
• Swift Message Delimiter - Message delimiter: {:5}.

• Swift File Name - Name of the ."TXT" file to process.

• InputDir - Location of the file - Example: C:\calypso\swiftmessages\

• File Rename - True or false - If true the file is renamed after processing, or not renamed otherwise.

• Gateway - Not used.

• ExternalMessageType - Not used.

seev.031 messages are integrated based on main tag <CorpActnNtfctn>

seev.035 messages are integrated based on main tag <CorpActnMvmntPrlimryAdvc>

seev.039 messages are integrated based on main tag <CorpActnCxlAdvc>

Record Date and Ex-Dividend Date
If the record date is missing (:98A::RDTE//), the date contained in the field :98C::RDDT// in Sequence E Corporate
Action Options (:16R:CAOPTN) is used to set the record date.

If there is no ex-dividend date (:98A::XDTE//), then the record date (:98A::RDTE//) is used to populate the ex-dividend
date.

If both:98C::RDDT// and :98A::RDTE// are missing, the user will add the record date manually in the CA product
making the CA option status = MANUAL.

10.2 .1 Integrat ion of Equi ty Corporate Act ions
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MT564 Notification Workflow
The system receives a MT564 and checks if there is an existing CA event with a "CAReference" equal to the MT564
Reference (tag 20C::CORP).

The CAReference already exists:

If the message is complete (tag 25D::PROC = COMP):

• A new message is saved with the SWIFT message as advice document

• The existing CA event is updated with Swift MT564 information

• Agent information is populated into the Corporate Action - Agent tab

• The message is linked to the existing CA event

If the message is not complete (tag 25D::PROC <> COMP)

• A new message is saved with the SWIFT message as advice document

• The existing CA event is NOT updated

• The message is linked to the existing CA event

The CAReference does not exist:

The system checks if there is an existing CA event with:

• An agent reference equal to the Swift message agent reference (tag 20C::SEM)

• A CA Swift Code equal to the swift message event code (tag CAEV)

• A CA ex date equal to the Swift message ex date (tag 98A::XDTE)

If so, it is the same process as when the CAReference already exists.

If not:

• A new message is saved with the Swift message as advice document

• A new CA event is saved using the Swift message information

• Agent information is populated into the Corporate Action - Agent tab

• The message is linked to the new CA event

When receiving the MT564 with field :23G:NEWM/COPY, the system updates the CA product with “Function of the
Message”.

MT566 Confirmation and MT568 Narrative Workflow
The system receives a MT566 / MT568 and checks if there is a CA event with a "CAReference" equal to the MT566-
MT568 Reference (tag 20C::CORP).
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The CAReference already exists:

• A new message is saved with the Swift message as advice document

• The message is linked to the existing CA event

The CAReference does not exist:

The system checks if there is an existing CA event with:

• An agent reference equal to the Swift message agent reference (tag 20C::SEM)

• A CA Swift Code equal to the Swift message event code (tag CAEV)

• A CA ex date equal to the Swift message ex date (tag 98A::XDTE)

If so, it is the same process as when the CAReference already exists.

If not:

• A new message is saved with the Swift message as advice document

• An exception task is generated to mention that the message is not linked to any CA event.

If field :20C::MITI// exists, it is saved in message attribute T2S_Ref.

10.2 .2 Sample DVCA MT564 Not i f icat ion

Swift Message
{1:F01HKMAHKHHAXXX6354508519}{2:O5641555101208CITIHKHXBXXX59954535991012072355N}{4:

:16R:GENL

:20C::CORP//39034104131

:20C::SEME//HK1034104133

:23G:NEWM

:22F::CAEV//DVCA

:22F::CAMV//MAND

:98C::PREP//20101207222107

:25D::PROC//COMP

:16S:GENL

:16R:USECU

:35B:ISIN BMG6873Y1176
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PAK FAH YEOW INTL

HKD0.05

:16R:FIA

:94B::PLIS//EXCH/XHKG

:16S:FIA

:16R:ACCTINFO

:97A::SAFE//12345

:93B::TRAD//UNIT/1,

:16S:ACCTINFO

:16S:USECU

:16R:CADETL

:98A::RDTE//20110103

:98A::XDTE//20101230

:22F::DIVI//INTE

:16S:CADETL

:16R:CAOPTN

:13A::CAON//001

:22F::CAOP//CASH

:17B::DFLT//Y

:92F::GRSS//HKD0,019

:16R:CASHMOVE

:22H::CRDB//CRED

:98A::PAYD//20110201

:16S:CASHMOVE

:16S:CAOPTN

:16R:ADDINFO

:95P::MEOR//CITIHKHX

:16S:ADDINFO

-}{:5}

After processing the above MT564, a message is generated and the incoming message is attached to the message.
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DVCA Corporate Action
Following the integration of the MT564, the following CA event is created and saved.

Details on the incoming message can be seen in the Incoming Message panel and Agent panel.
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10.2 .3 Sample Incomplete MT564 Not i f icat ion
.

Swift Message
Assume you receive firstly an incomplete MT564 from your agent. In this example the payment date is OPEN

{1:F01HKMAHKHHAXXX6354508519}{2:O5641555101208CITIHKHXBXXX59954535991012072355N}{4:

:16R:GENL

:20C::CORP//39034104131

:20C::SEME//HK1034104133

:23G:NEWM

:22F::CAEV//DVCA

:22F::CAMV//MAND

:98C::PREP//20101207222107

:25D::PROC//PREC

:16S:GENL

:16R:USECU

:35B:ISIN BMG6873Y1176

PAK FAH YEOW INTL

HKD0.05

:16R:FIA

:94B::PLIS//EXCH/XHKG

:16S:FIA
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:16R:ACCTINFO

:97A::SAFE//12345

:93B::TRAD//UNIT/1,

:16S:ACCTINFO

:16S:USECU

:16R:CADETL

:98A::RDTE//20110103

:98A::XDTE//20101230

:22F::DIVI//INTE

:16S:CADETL

:16R:CAOPTN

:13A::CAON//001

:22F::CAOP//CASH

:17B::DFLT//Y

:92F::GRSS//HKD0,019

:16R:CASHMOVE

:22H::CRDB//CRED

:98B::PAYD//OPEN

:16S:CASHMOVE

:16S:CAOPTN

:16R:ADDINFO

:95P::MEOR//CITIHKHX

:16S:ADDINFO

-}{:5}

After importing and processing the MT564, a new message is generated and the incoming message is attached to the
message.

Corporate Action
A corporate action is created using the incoming message information.

The corporate action's Processing Status is PREC.

The Option Status is NOT_APPLICABLE because the payment date is missing.
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A new Swift MT564 is received from the agent, and processed to update the information. A new message is
generated and is linked to the existing CA event.

The Processing Status of the CA event moves from PREC to COMP.

The CA event is updated with the payment date.

The Option Status moves from NOT_APPLICABLE to APPLICABLE.
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10.2 .4 Sample MT566 Conf i rmat ion

Swift Message
The system receives a MT566 confirmation.

{1:F01HKMAHKHHAXXX6354508519}{2:O5661555101208CITIHKHXBXXX59954535991012072355N}{4:

:16R:GENL

:20C::CORP//DIV3437592

:20C::SEME//253147817

:20C::COAF// BI01593212345

:23G:NEWM

:22F::CAEV//DVCA

:16R:LINK

:13A::LINK//564

:20C::PREV//253147815

:16S:LINK

:16S:GENL

:16R:USECU

:97A::SAFE//98-0112441-05

:35B:ISIN JP3356500003 SHIMA SEIKI MANUFACTURING ORD

:93B::ELIG//UNIT/4600,

:93B::CONB//UNIT/4600,

:16S:USECU

:16R:CADETL

:98A::XDTE//20100925

:98A::RDTE//20101002

:98A::PAYD//20101004

:16S:CADETL

:16R:CACONF

:13A::CAON//001

:22F::CAOP//CASH

:92A::TAXR//15,
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:16R:CASHMOVE

:22H::CRDB//CRED

:19B::GRSS//JPY69000,

:19B::TAXR//JPY10360,

:19B::NETT//JPY58640,

:19B::PSTA//JPY58640,

:98A::POST//20101004

:98A::VALU//20101004

:16S:CASHMOVE

:16S:CACONF

-}{:5}

A newmessage is created and linked to the existing corporate action event. The tag :20C::CORP//DIV3437592 is
used to retrieve the proper corporate action.

Corporate Action
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10.2 .5 Sample MT568 Narrat ive
Assume you have the below corporate action event:
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Agent CA reference is 39034104131.

Swift Message
The system receives a MT568:

{1:F01HKMAHKHHAXXX6330508501}{2:O5681400110228CITIHKHXBXXX59904535011102282100N}{4:

:16R:GENL

:20C::CORP//39034104131

:20C::SEME//HK1034104148

:23G:NEWM

:22F::CAEV//DVCA

:98C::PREP//20101207222107

:16R:LINK

:22F::LINK//WITH

:13A::LINK//564

:20C::PREV//HK1034104133
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:16S:LINK

:16S:GENL

:16R:USECU

:97A::SAFE//12345

:35B:ISIN BMG6873Y1176

PAK FAH YEOW INTL

HKD0.05

:16S:USECU

:16R:ADDINFO

:70F::ADTX//

--------------- EVENT DETAILS -------------------

A CASH DIVIDEND HAS BEEN ANNOUNCED FOR THE ABOVE-MENTIONED SECURITY. .

INFORMATION PROVIDED IS BASED ON INFORMATION AVAILABLE TO THE CUSTODIAN/CLEARING AGENT.
THE CUSTODIAN/CLEARING AGENT DOES NOT WARRANT THAT THE INFORMATION IT HAS RECEIVED IS
ACCURATE

OR COMPLETE.

-------------- ACTION TO BE TAKEN ---------------

FOR INFORMATION ONLY NMSG/END

:16S:ADDINFO

-}{:5}

A newmessage is generated and is automatically linked to the corporate action having an agent CA reference equal
to 39034104131.

Corporate Action

10.2 .6 Integrat ion of Bond Corporate Act ions

MT564, MT566 and seev Messages Integration
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The corporate action (CA) process for bonds works in two steps in the system: first the system creates the CA
product from the bond cashflows, then the system applies this CA product to the positions (inventory and P&L
positions) and creates the CA trades.

The system offers the possibility to:

• Import MT564 messages that are indexed and reconciled to existing CA products

• Import MT566 (NEWM and REVR) messages that are indexed and reconciled to existing CA transfers

When MT56X messages are imported, the system tries to index the incoming messages to existing CAs, using the
following logic:

If a MT56X has already been imported for this CA:

• When a MT56X message is imported, the system stores the CA Id (calypso reference) as a message attribute
(CAReference) of the MT56X message. It means that if a MT56X is imported and TAG 20C::RELA is present, the
system will retrieve the CA Id from the previously sent MT56X.

• If TAG 20C::RELA is not present, the system can use the CA Agent Reference to link MT56X to a CA Id. The CA
AGENT REFERENCE is provided in TAG 20C::CORP of the MT56X. The value of this TAG can be matched with the
CA AGENT REFERENCE coming from the Agent details, the agent details being linked to the CA product in
calypso.

If a MT56X has not already been imported:

• If the system wasn't able to retrieve the CA product using TAG 20C::RELA or TAG 20C::CORP, then the system will
look if a CA exists using several criteria:

– The ex date (stored on CA product): Content of the field:98A::XDTE// (or 98A::MATU//)

– CA Bond Model and subtype (stored on CA product): Content of the field 22F::CAEV//

– ISIN (stored on Bond definition): Content of the field:35B:ISIN

Consistency checks are implemented to make sure the CA is in synch with the MT56X. If a check fails, the MT56X is
still indexed to the CA but the MT56X is blocked in the workflow and ab exception is raised. The action REPROCESS
with rule ReprocessIncoming can be used once the matching issue is fixed.

The fields to be matched when importing seev messages can be configured in the CASwiftEventCodeAttributes
window under Trade Lifecycle > Corporate Action > CA Swift Event Code (menu action
product.CASwiftEventCodeAttributesWindow).
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MT566 NEWM Indexation to CA Trade/Transfer
The incoming MT566 is linked to an existing CA trade. The system retrieves a CA trade with the following conditions:

• trade counterparty = SENDER of the message

• trade counterparty role = Agent

• trade status NOT CANCELED

• trading book = CAAdjustBook (NB: the CAAdjustBook book attribute is mandatory and must be unique by PO)

• same CAReference (ie same CA ID)

• same custodian account. Agent account reference is provided in TAG 97A of the MT566 and can be used to
retrieve the correspondent Settle Account in the system.

If a unique CA trade is found, the system will index the MT566 to a CA transfer, and apply the action SETTLE or
PARTIAL_SETTLE if the amount is within the tolerance amount. The real settle date of the SETTLED transfer is
updated with the content of TAG 98a::POST.

If no (or multiple) CA trade is found, the incoming message is indexed to the CA id, but not to the trade id. The user will
have to manually match a transfer with the message using the Security Matching window.

MT566 REVR Processing
In case of reversal MT566 (23G = REVR), the system retrieves the previous message reference from TAG 20C::PREV
(mandatory as per conditional rule C2 of swift doc) in order to link the reversal with the newMT566 (see field Msg
Linked Id).

In case of reverse of perfect match, the system (MatchIncomingSecurity rule) applies the action REVERSE on the
SETTLED transfer to move it back to VERIFIED.

In case of reverse of partial settlement (mismatch), the system applies the action REVERSE (rule UnSplitXfer) on the
SPLIT transfer. As a consequence the SETTLED/FAILED child transfers are all CANCELED and the system creates a
new transfer for the full amount.
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In case previous NEWMMT566 is not indexed to a transfer, the system (rule ReverseLinkedMessage) applies the
action REVERSE on the MT566 to move both NEWM and REVR in REVERSED status.

Security Matching Window and Manual Match
In case no eligible trade/transfer was found, the user will have to manually match incoming MT566 with CA transfers.

FilterSet with book = CAAdustBook must be defined to only load relevant transfers.

From the Calypso Navigator, navigate to Processing > Matching > Security Matching (menu action
reporting.SecurityMatchingWindow) to bring up the Security Matching window.

• MATCH button - Within CAManual tolerance: It is possible to define a CAManual tolerance type for manual
matching. Manual tolerance can be defined at sub-custodian, Agent or PO level (to be retrieved in this order).

• FORCE MATCH button: The user also has the possibility to force the match of incoming MT566. In that case, the
system does not perform any consistency check. The system will apply the action MATCH on the message and
SETTLE the selected transfer. The access permission Manual Match must be granted to the user.

CONV and PARI MT564 Processing
MT56x indexation and matching logic with CA product (for CONV and PARI) follows the current process of CA for
Bonds.
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When the MT564 is received,, if the CA does not exist, the incoming message is stopped by the workflow waiting for
the CA to be created.

CONV

The conversion is handled on the Bond definition window.

The Convertible Panel must be used to define what would be the eligible target Equity.

Please refer to "Specifying Convertible Bonds" of the Calypso documentation Defining Bond Products to set up the
convertible option and generate the related CA.

Notes:

• On the Conversion Schedule panel, the Redemption Date will be the payment date and the Notification Date will
be the Ex and the Record dates.

• The field “Exercised?” must be set to Yes

• The Bond Unit and Target Unit define the From and To Ratio

PARI

The assimilation is handled on the Bond definition window in the Special Panel.

The Assimilation Prd and the Assimilation Date must be filled in by the user

By default the Assimilation Date is the EX, the record and the payment date. They can be modified in the CA window
after initial saving.

TEND, BIDS, EXOF and NOOF MT564 Processing
MT564 indexation to CA product for TEND, BIDS, EXOF and NOOF is a special process.

For these corporate actions, if no previous CA exists for the same event/ex-date/ISIN, the processing of a correct
MT564 will issue a creation of a CA product as if it was manually created by an end user.

When MT564 messages are imported, the system tries to index the incoming messages to existing CAs, using the
following criteria:

• CA event type

• ISIN

• Ex-Date

If no CA is found then the system creates the CA product and the message is PROCESSED

MT566 NEWM Processing
MT566 are handle by the system depending on the constituent of the message.
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CASHMOV processing

When the MT566 is composed of both Security and Cash or Cash only, the behavior is the same as the one for the
standard CA for Bonds (INTEREST, REDEMPTION...).

Only one incoming message is saved, then the system tries to match the cash part (SETTLE or PARTIAL SETTLE) and
then applies the same action the SECURITY Xfer of the related CA trade. The Security Matching window can be used
to manually match these Xfers.

SECMOVE processing

When the MT566 is only composed of Security, the system split the MT566 in as many part as SECMOVE part. Several
incoming messages are saved, one per ISIN.

The system then tries to perfectly match the number of securities and then apply the SETTLE action on the related
Xfer of the CA trade.

MT566 REVR processing

The processing of the Revert MT566 which includes CASHMOV follows the same principle as standard MT566 for
Bonds. For MT566 including SECMOVE the process is manual.

10.3 Integrat ion Process for Sub-Accounts
Integration by sub-account is triggered if the sender LE attribute "UseSubBalance" is set to true.

Pre-Requisite configuration: CAAdjustment book per PO, attached to each trading book respectively, using the book
attribute CAAdjustBook.

When processing the CA trades on the inventory position, the system creates a CA trade on the aggregated position
per proprietary account, representing the sum of the CA trades entitlement per sub-account belonging to this
proprietary account.

The incoming MT566 is indexed against the aggregated position per proprietary account.

• Each CA trade against the CAAdjustment book and proprietary account generate transfer (s) to impact inventory
position of Agent/Proprietary account/CAAdjustment book

• Each CA trade against the trading book and the sub-accounts generate:

– Transfers to impact inventory position of Agent/Sub-account/Trading book

– Transfers in opposite direction to impact inventory position of Agent/Proprietary account/CAAdjustment
book

At payment date of each CA, the inventory position of Agent/Proprietary account/CAAdjustment book is null.

The rule CAAdjustBookLinkedXfer applies the same action on the CA trade against the CAAdjustment book to the
linked CA trades/transfers against the trading book.
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10.4 Reconci l ing El igible Posit ions with MT564
The rule PropagateMT564EligibleQuantity propagates quantity from the message attribute "Eligible", quantity type
from the message attribute "EligibleQuantityType" and the incoming message ID. The below list of attributes is
required to identify the corresponding CA trade and link them with the incoming MT564 message:

l EligibleQuantityType
l PO_BIC
l Agent_BIC
l SafekeepingPlace
l RelatedMessageReference
l Indicator

This will allow to identify (before Payment Date) any potential discrepancy between the balance provided in the
incoming MT564 and the balance recorded, available in the CA Trade Keyword “CAEligibleQuantity” retrieved from
Inventory Position, which will reduce the risk of failed settlements when receiving the MT566 on Payment Date.

Nasdaq Calypso
Corporate Actions / Version 18



11. Corporate Action Swift Codes
The mapping between Swift Codes and corporate action types can be defined using Trade Lifecycle > Corporate
Action > CA Swift Event Code.

This table summarizes the CA models/subtypes mapping done per CA SWIFT event code.

It also allows you to add your own mapping as applicable.

You can double-click the CAModelSubtype field to bring up the model / subtype selection window:

The first model / subtype will be selected by default when the corresponding swift code is selected in the Corporate
Action window.

You can move selected model / subtypes up and down, add model / subtypes, and remove model / subtypes.

When you click OK, you can then select the Swift Event Option (outcome).
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Click Save to save your changes, if any.

Note that if the Authorization mode is enabled, an authorized user must approve your entry.

You can click to configure the display.

You can also set default values for the other fields. You can add fields for which you want to set default values by
adding them to the domain "CASwiftEventCodeAttributes", and they will appear in this table.

For example, if you add Start Date to the domain "CASwiftEventCodeAttributes", it will appear in this table so that you
can give it a default value.
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The list of attributes available for customization are defined in the file "CAAttributeDefinition.xsd" located under
<calypso home>/client/resources/com/calypso/tk/product/corporateaction.

 Ⓘ [NOTE: Changes to resources have to be re-deployed to your application servers. Please refer to the
Calypso Installation Guide for details]
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12. Corporate Action Audit Report
The Corporate Action Audit report allows viewing audit information for corporate action definitions. It shows the list of
selected corporate actions and the corresponding audit information.

For reference, Corporate Actions are defined using Trade Lifecycle > Corporate Action > Corporate Action.

From the Calypso Navigator, navigate to Reports > Audit > CA Audit (menu action
reporting.ReportWindow$CAAudit) to bring up the report.

 Ⓘ [NOTE: You can configure the columns. Sort columns, subheadings and subtotals have to be explicitly
specified. Choose Help > Menu Items for details]

» You can change the pricing details at the bottom of the window - By default, the pricing environment comes from
the User Defaults, and the valuation date is the current date and time.

» You can check / uncheck View > Show Frame > Criteria to display / hide the search criteria.

» Specify search criteria as applicable and click to load the corresponding corporate actions.

You can specify search criteria to load corporate actions in the "Corporate Action Selection" area.

You can specify search criteria for audit information in the "AuditValue Selection Criteria" area.
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» You can select a template, and click to display the number of objects that will be loaded from the database,
before loading the report.

» You can click to print the report results.

Note that for the Pivot view and the Aggregation view, the print icon is disabled.

You can use [Ctrl+P] or [Ctrl+L] to print the report, or you can export the report to Excel and print it from there.

The first report shows the selected corporate actions, and the second report shows the corresponding audit
information.

You can customize the display of the "Field Name" column in the domain "CAAuditReportField". The value should be
the field name (as it appears by default), and the comment should be the display name.

Example:
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